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Read this manual carefully before you use this machine and keep it handy for future reference. For safe and correct use, be sure to read the
Safety Information in "About This Machine" before using the machine.

Introduction
This manual contains detailed instructions and notes on the operation and use of this machine. For your
safety and benefit, read this manual carefully before using the machine. Keep this manual in a handy
place for quick reference.
Important
Contents of this manual are subject to change without prior notice. In no event will the company be liable for direct, indirect, special, incidental, or consequential damages as a result of handling or operating the machine.
Do not copy or print any item for which reproduction is prohibited by law.
Copying or printing the following items is generally prohibited by local law:
bank notes, revenue stamps, bonds, stock certificates, bank drafts, checks, passports, driver's licenses.
The preceding list is meant as a guide only and is not inclusive. We assume no responsibility for its
completeness or accuracy. If you have any questions concerning the legality of copying or printing certain items, consult with your legal advisor.
Caution:
Use of controls or adjustments or performance of procedures other than those specified in this manual
might result in hazardous radiation exposure.
Two kinds of size notation are employed in this manual. With this machine refer to the inch version.
Trademarks
Microsoft®, Windows® and Windows NT® are registered trademarks of Microsoft Corporation in the
United States and/or other countries.
Adobe®, PostScript®, Acrobat®, PageMaker® and Adobe Type Manager are registered trademarks of
Adobe Systems Incorporated.
PCL® is a registered trademark of Hewlett-Packard Company.
Apple, AppleTalk, EtherTalk, Macintosh, Mac OS and True Type are registered trademarks of Apple
Computer, Inc.
BonjourTM is a trademark of Apple Computer, Inc.
IPS-PRINTTM Printer Language Emulation Copyright© 2000, Oak Technology, Inc., All Rights Reserved.
UNIX is a registered trademark in the United States and other countries, licensed exclusively through
X/Open Company Limited.
The Bluetooth® word mark and logos are owned by the Bluetooth SIG, Inc. and any use of such marks
by Ricoh Company, Ltd. is under license.
NetWare is a registered trademark of Novell, Inc.
Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights to those marks.
The proper names of the Windows operating systems are as follows:
• The product name of Windows® 95 is Microsoft® Windows® 95
• The product name of Windows® 98 is Microsoft® Windows® 98
• The product name of Windows® Me is Microsoft® Windows® Millennium Edition (Windows Me)
• The product name of Windows® 2000 are as follows:
Microsoft® Windows® 2000 Professional
Microsoft® Windows® 2000 Server
Microsoft® Windows® 2000 Advanced Server
• The product name of Windows® XP are as follows:
Microsoft® Windows® XP Home Edition
Microsoft® Windows® XP Professional
• The product names of Windows ServerTM 2003 are as follows:
Microsoft® Windows ServerTM 2003 Standard Edition
Microsoft® Windows ServerTM 2003 Enterprise Edition
Microsoft® Windows ServerTM 2003 Web Edition
• The product name of Windows NT® 4.0 are as follows:
Microsoft® Windows NT® Workstation 4.0
Microsoft® Windows NT® Server 4.0
Notes
Some illustrations in this manual might be slightly different from the machine.
Certain options might not be available in some countries. For details, please contact your local dealer.

Manuals for This Machine
Refer to the manuals that are relevant to what you want to do with the machine.

❖ About This Machine
Be sure to read the Safety Information in this manual before using the machine.
This manual provides an introduction to the functions of the machine. It also
explains the control panel, preparation procedures for using the machine,
how to enter text, and how to install the CD-ROMs provided.
❖ General Settings Guide
Explains User Tools settings, and Address Book procedures such as registering e-mail addresses, and user codes. Also refer to this manual for explanations on how to connect the machine.
❖ Trouble Shooting
Provides a guide to solving common problems, and explains how to replace
paper, toner, staples, and other consumables.
❖ Security Reference
This manual is for administrators of the machine. It explains security functions that the administrators can use to protect data from being tampered, or
prevent the machine from unauthorized use.
Also refer to this manual for the procedures for registering administrators, as
well as setting user and administrator authentication.
❖ Copy/Document Server Reference
Explains Copier and Document Server functions and operations. Also refer to
this manual for explanations on how to place originals.
❖ Printer Reference
Explains Printer functions and operations.
❖ Scanner Reference
Explains Scanner functions and operations.
❖ Network Guide
Explains how to configure and operate the machine in a network environment, and use the software provided.
This manual covers all models, and includes descriptions of functions and
settings that might not be available on this machine. Images, illustrations, and
information about operating systems that are supported might also differ
slightly from those of this machine.
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❖ Other manuals
• Manuals for This Machine
• Safety Information
• Quick Reference Copy Guide
• Quick Reference Printer Guide
• Quick Reference Scanner Guide
• PostScript3 Supplement
• UNIX Supplement
• Manuals for DeskTopBinder Lite
• DeskTopBinder Lite Setup Guide
• DeskTopBinder Introduction Guide
• Auto Document Link Guide
Note
❒ Manuals provided are specific to machine types.

❒ Adobe Acrobat Reader/Adobe Reader must be installed in order to view the
manuals as PDF files.
❒ For “UNIX Supplement”, please visit our Web site or consult an authorized
dealer.
❒ “PostScript3 Supplement” and “UNIX Supplement” include descriptions of
functions and settings that might not be available on this machine.
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How to Read This Manual
Symbols
This manual uses the following symbols:
Indicates important safety notes.
Ignoring these notes could result in serious injury or death. Be sure to read these
notes. They can be found in the "Safety Information" section of About This Machine.
Indicates important safety notes.
Ignoring these notes could result in moderate or minor injury, or damage to the
machine or to property. Be sure to read these notes. They can be found in the
"Safety Information" section of About This Machine.
Indicates points to pay attention to when using the machine, and explanations
of likely causes of paper misfeeds, damage to originals, or loss of data. Be sure
to read these explanations.
Indicates supplementary explanations of the machine’s functions, and instructions on resolving user errors.
This symbol is located at the end of sections. It indicates where you can find further relevant information.
[]
Indicates the names of keys that appear on the machine’s display panel.
{}
Indicates the names of keys on the machine’s control panel.
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Display Panel
This section describes configuration using the display panel when the printer
function is selected.

Initial Display
Important
❒ The machine switches to offline when you make settings when the machine
is online. After you complete the setting, the machine switches to online automatically.

❒ If you make a setting when the machine is offline, it will stay offline afterwards.
❒ The function items displayed serve as selector keys. You can select or specify
an item by pressing it lightly.
❒ When you select or specify an item on the display panel, it becomes highlighted.
❒ Keys dimmed (for example,
) cannot be used.

1

2
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1. Operational status or messages

3. [Form Feed]

Displays current machine status, such as
“Ready”, “Offline”, and “Printing...”. Information about the print job (user ID
and document name) appears in this section.

Press to print all the data left in the machine's input buffer.

2. [fOnline]/[ Offline]
When you press these keys, the machine
switches between online and offline.
When the machine is online, it can receive data from the computer.
When the machine is offline, it cannot receive data from the computer.
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• When the machine is online, the status
appears dimly.
• This function is not available with the
RPCS printer language.

4. [Job Reset]
Press to cancel the current print job.
If you press it when the machine is offline
and Hex Dump is selected, Hex Dump is
canceled.

5. [Print Jobs]

7. [Spooling Job List]

Press to display print jobs sent from a
computer.

Press to display spooled jobs.

6. [Error Log]

The paper tray settings appear.

8. Paper Tray Status indicators

Press to display the error logs of print
jobs that sent from a computer.

Note
❒ When the power is turned on, the copier display is shown. This is a factory
default. This initial setting can be changed. See “System Settings”, General
Settings Guide.

Simplified Display
This section explains how to switch to the simplified display.
When you press {Simplified Display}, the screen changes from the initial display
to the simplified display. Letters and keys are displayed at a larger size, making
operations easier.

ANV202S

❖ Example of a simplified display

Note
❒ To return to the initial display, press {Simplified Display} again.

❒ Certain keys do not appear on the simplified display.
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Job List
Jobs printed using Copy, Document Server, or Printer mode are temporarily
stored in the machine, and then executed in order. The Job List function allows
you to manage these jobs. For example, you can cancel incorrect job settings or
print an urgent document.
Note
❒ You cannot use the Job List function when Interrupt Copy is active.

Job List screen
This section explains displays and icons that appear in the Job List screen.
The Job List screen varies depending on whether [Job Order] is selected with
Print Priority for the System Settings. For details about the setting procedure, see
“General Features”, General Settings Guide.

❖ When [Job Order] is not selected:
The job list is displayed for each of the functions.
1
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❖ When [Job Order] is selected:
The job list is displayed for all functions in the order of print jobs.
2
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A
B
C
D

Switches between job lists for each function.
Switches between [Current / Waiting Job List] and [Job History].
Displays reserved job numbers.
Displays the function used to print jobs.
: Job printed using copy function.
: Job printed using printer function.
: Job printed using Document Server function.
: Job printed using DeskTopBinder.
: Job printed using Web Image Monitor.
Reference
“General Features”, General Settings Guide

Checking jobs in the print queue
You can check the contents of jobs in the print queue.

A Press [Job List].
B Select the job you want to check.

C Press [Details], and then check the contents.
D Press [Exit].
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Changing the order of jobs
You can change the order in which print jobs in the job list are served:

A Press [Job List].
B Select the job whose order you want to change.

C Press [Change Order].
D Change the order using [Top], [Previous], or [Next].

E Press [OK].
Holding print jobs
The machine holds jobs that are queued and currently printing.

A Press [Job List].
B Select the job(s) to hold.

C Press [Suspend Printing].
6

Deleting jobs
You can delete job that is queued or currently printing.

A Press [Job List].
B Select the job you want to delete.

To delete multiple print jobs, select all print jobs you want to delete.

C Press [Delete Reservation].
D Press [Yes].
Note
❒ To delete multiple print jobs, select them in step B.

Checking Job History
You can view the history contents of printed jobs.

A Press [Job List].
B Press [Job History].
A list of completed print jobs appears.

C Press [Details] to check the contents of the displayed jobs.
D Press [Exit].
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Printer Features Menu
The following explains settings and meanings of functions on Printer Feature.
Printer Feature screen appears when you press the {User Tools/Counter} key. For
details, see “Printer Features”, General Settings Guide.

❖ List/Test Print
Menu

Description

Multiple Lists

You can print the configuration page and error
log.

Configuration Page

You can print the machine's current configuration values.

ErrorLog

You can print error logs listing all errors that
occurred during printing.

Menu List

You can print a Menu List showing the machine's function menus.

PCL Configuration / Font Page

You can print the current configuration and
installed PCL font list.

PS Configuration / Font Page

You can print the current configuration and
installed PostScript font list.
This menu can be selected only when the optional PostScript 3 unit is installed.

PDF Configuration / Font Page

You can print the current configuration and
installed PDF font list.
This menu can be selected only when the optional PostScript 3 unit is installed.

Hex Dump

You can print in the Hex Dump mode.

❖ Maintenance
Menu
Menu Protect

Description
This function lets you protect menu settings
from accidental change. It makes it impossible to change menu settings with normal
procedures unless you perform the required
key operations.
In a network environment, only administrators can make changes to menu settings.
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List / Test Print Lock

You can lock the [List / Test Print] menu.

Delete All Temporary Print Jobs

You can delete all print jobs temporarily
stored in the machine.

Delete All Stored Print Jobs

You can delete all print jobs stored in the machine.

❖ System
Menu

Description

Print Error Report

You can print an error report when a printer
or memory error occurs.

Auto Continue

You can select this to enable Auto Continue.
When it is On, printing continues after a system error occurs.

Memory Overflow

Select this to have a memory overflow error
report printed.

Job Separation

You can enable Job Separation.
This menu can be selected only when a finisher (optional) is installed.

Auto Delete Temporary Print Jobs

You can select to automatically delete print
jobs temporarily stored in the machine.

Auto Delete Stored Print Jobs

You can select to automatically delete print
jobs stored in the machine.

Initial Print Job List

You can set the default Printer screen when
you press [Print Jobs].

Memory Usage

You can select the amount of memory used
in Font Priority or Frame Priority, according
to paper size or resolution.

Duplex

You can select to have print on both sides of
each page.

Copies

You can specify the number of print sets.
This setting is disabled if the number of pages to print has been specified with the printer
driver or another command.

Blank Page Print

You can select whether or not to print blank
pages.

Toner Saving

Make setting to select either to apply or not
to apply Toner Saving.

Spool Image

You can select to print spool images.
The print job transmitted from the computer
is temporarily stored on the machine's hard
disk as bitmap images that can be printed
when transmission is complete.

Reserved Job Waiting Time

You can specify how long the machine waits
to receive a print job before allowing other
functions such as the copier and scanner
functions to interrupt it.

Printer Language

You can specify the printer language.

Sub Paper Size

You can enable the Auto Substitute Paper
Size (A4↔LT) feature.

Page Size

You can select the default paper size.
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Menu
Letterhead Setting

Description
You can rotate original images when printing.
When printing, original images are always
rotated by 180 degrees. Therefore, output
might not be as expected when printing onto
letterhead or preprinted paper requiring orientation. Using this function, you can specify
image rotation.

Bypass Tray Setting Priority

You can specify which of the two options,
(Printer) Driver / Command or Machine Settings, has priority for determining the paper
size for the bypass tray.

Edge to Edge Print

You can select whether or not to print on the
entire sheet.

Default Printer Language

You can set the default printer language if
the machine cannot find the printer language
automatically.

Tray Switching

You can set to switch the paper tray.

❖ Host Interface
Menu

Description

I/O Buffer

You can set the size of the I/O Buffer. Normally it is not necessary to change this setting.

I/O Timeout

You can set how many seconds the machine
should wait before ending a print job. If data
from another port usually arrives in the middle of a print job, you should increase this
timeout period.

❖ PCL Menu
Menu
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Description

Orientation

You can set the page orientation.

Form Lines

You can set the number of lines per page.

Font Source

You can set the storage location of the default
font.

Font Number

You can set the ID of the default font you
want to use.

Point Size

You can set the point size you want to use for
the selected font.

Font Pitch

You can set the number of characters per
inch for the selected font.

Symbol Set

You can specify the set of print characters for
the selected font. The available options are as
follows:

Courier Font

You can select a courier font type.

Extend A4 Width

You can extend the printing area width
when printing on A4 sheet with PCL.

Menu

Description

Append CR to LF

When set to On, a carriage return will follow
each line feed: CR=CR, LF=CR−LF, FF=CR−
FF.

Resolution

You can set the print resolution in dots per
inch.

❖ PS Menu (optional)
Menu

Description

Data Format

You can select a data format.

Resolution

You can set the print resolution in dots per
inch.

❖ PDF Menu (optional)
Menu

Description

Change PDF Password

You can set the password for the PDF file executing PDF Direct Print.

PDF Group Password

You can set the group password already
specified with DeskTopBinder Lite.

Resolution

You can set the print resolution in dots per
inch.

Note
❒ Some options do not appear depending optional units or selected printer languages.

❒ Some options cannot be set depending on security settings.
Reference
For details, see “Printer Features”, General Settings Guide.

For more information about copier features and system settings, see Copy
Reference and General Settings Guide.
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Setting Paper on the Bypass Tray
This section gives instructions for setting paper on the bypass tray.
For details about paper size and paper type, see “Recommended Paper Size and
Types”, About This Machine.
Important
❒ The following functions are disabled when printing from the bypass tray:
• Duplex/Booklet printing
• Auto Tray Select
• Auto Tray Switching
• Rotating Collate
• Staple (when the optional unit is installed)
• Punch (when the optional unit is installed)
• Z-fold (when the optional unit is installed)

A Open the bypass tray.
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B Gently insert paper face up into the bypass tray until the beeper sounds,

and then adjust the paper guides to the paper size.
If the paper size of the paper guide and the paper do not match, skewing and
misfeeds might occur.
Do not stack paper over the limit mark, otherwise a skewed image or misfeeds might occur.
Open out the extender to support paper sizes larger than A4 L, 81/2 ×11 L.
Fan the paper to get air between the sheets to avoid a multi-sheet feed.

2
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1. Paper Guide
2. Extender

C Set the paper size using the printer driver or the control panel.
The following procedures are not required if you select [Driver / Command]
from [Bypass Tray Setting Priority] in [System] of [Printer Features]. In that case,
set the paper size using the printer driver.
Note
❒ Paper sizes that can be loaded onto the bypass tray are 100 - 305 mm (3.9 12 in.) vertical, and 139.7 - 600 mm (5.5 - 23.7 in.) horizontal.

❒ If 3,000Sheet-100Sheet Staple Finisher is installed, paper of the following
dimensions can be loaded onto the bypass tray: 100 - 305 mm (3.9 - 12 in.)
vertical, and 139.7 - 458 mm (5.5 - 18.1 in.) horizontal.
❒ When loading OHP transparencies or thick paper, set paper size and paper
type.
❒ The number of sheets that can be loaded in the bypass tray depends on the
paper type.
Reference
When loading letterhead paper, pay attention to its orientation. See General Settings Guide.

For printer driver settings, see the printer driver Help.
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Setting the Paper Size Using the Control Panel
Follow the procedure below to set the machine using the control panel when
loading standard size paper onto the bypass tray.
Important
❒ The following procedures are not required if you select [Driver / Command]
from [Bypass Tray Setting Priority] in [System] of [Printer Features] (see “Printer
Features”, General Settings Guide). In that case, set the paper size using the
printer driver. For details, see General Settings Guide.

❒ If you select [Machine Settings] from [Bypass Tray Setting Priority] in [System] of
[Printer Features] (see “Printer Features”, General Settings Guide), the settings
made using the control panel have priority over the printer driver settings.
❒ If the printer driver is not used, select [Machine Settings] from [Bypass Tray Setting Priority] in [System] of [Printer Features] (see “Printer Features”, General Settings Guide). Set paper size using the control panel.

A Press the {User Tools/Counter} key on the control panel.
B Press [System Settings].
C Press the [Tray Paper Settings] tab.
D Press [Printer Bypass Paper Size].

E Select the paper size.
F Press [OK].
G Press the {User Tools/Counter} key.
The initial screen appears.
Note
❒ When loading OHP transparencies or thick paper, set paper size and paper
type.
Reference
For printer driver settings, see the printer driver Help.
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Setting Custom Size Paper Using the Control Panel
Follow the procedure below to set the machine using the control panel when
loading custom size paper onto the bypass tray.
Important
❒ The following procedures are not required if you select [Driver / Command]
from [Bypass Tray Setting Priority] in [System] of [Printer Features] (see “Printer
Features”, General Settings Guide). In that case, set the paper size using the
printer driver.
❒ If you select [Machine Settings] from [Bypass Tray Setting Priority] in [System] of
[Printer Features] (see “Printer Features”, General Settings Guide), the settings
made using the control panel have priority over the printer driver settings.
❒ If the printer driver is not used, select [Machine Settings] from [Bypass Tray Setting Priority] in [System] of [Printer Features] (see “Printer Features”, General Settings Guide). Set paper size using the control panel.

A Press the {User Tools/Counter} key on the control panel.
B Press [System Settings].
C Press the [Tray Paper Settings] tab.
D Press [Printer Bypass Paper Size].
E Press [Custom Size].

If a custom size is already set, press [Change Size].

F Press [Vertical], enter the vertical size of the paper using the number keys,
and then press the {q} key.

G Press [Horizontal], enter the horizontal size of the paper using the number
keys, and then press the {q} key.

H Press [OK].
The paper sizes entered are displayed.

I Press the {User Tools/Counter} key.
The initial screen appears.
Note
❒ When loading OHP transparencies or thick paper, set paper size and paper
type.
❒ For printer driver settings, see the printer driver Help.
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Setting Thick Paper or OHP Transparencies Using the Control Panel
Follow the procedure below to set the machine using the control panel when
loading thick paper or OHP transparencies onto the bypass tray.
Important
❒ The following procedures are not required if you select [Driver / Command]
from [Bypass Tray Setting Priority] in [System] of [Printer Features] (see “Printer
Features”, General Settings Guide). In that case, set the paper size using the
printer driver.

❒ If you select [Machine Settings] from [Bypass Tray Setting Priority] in [System] of
[Printer Features] (see “Printer Features”, General Settings Guide), the settings
made using the control panel have priority over the printer driver settings.
❒ If the printer driver is not used, select [Machine Settings] from [Bypass Tray Setting Priority] in [System] of [Printer Features] (see “Printer Features”, General Settings Guide). Set the paper size using the control panel.

A Press the {User Tools/Counter} key on the control panel.
B Press [System Settings].
C Press the [Tray Paper Settings] tab.
D Press [TNext] to scroll through the list.
E Press [Paper Type: Bypass Tray].
F To print on OHP transparencies, press [OHP (Transparency)] in the [Paper
Type] area. To print on thick paper, press [Thick paper] in the [Paper Type] area.

G Press [OK].
The paper type selected is displayed.
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H Press the {User Tools/Counter} key.
The initial screen appears.
Note
❒ The settings made will remain valid until they are reset again. After printing on OHP transparencies or thick paper, make sure to clear settings for
the next user.

❒ For printer driver settings, see the printer driver Help.
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1. Preparing the Machine
Confirming the Connection Method
This machine supports network and local connection.
Before installing the printer driver, check how the machine is connected. Follow
the driver installation procedure that is appropriate to the connection method.

Network Connection
This machine can be used as a Windows printing port or network printer.

Using This Machine as the Windows Printing port
Network connections can be established through Ethernet, IEEE 802.11b, and
IEEE 1394 (IPv4 over 1394).
Available ports are determined based on the combination of Windows operating
system version and connection method used.

ZZZ035S

❖ Windows 95 / 98
Connection Method

Available Ports

Ethernet / IEEE 802.11b

SmartDeviceMonitor for Client port

IEEE 1394 (IPv4 over 1394)

None
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Preparing the Machine

❖ Windows Me

1

Connection Method

Available Ports

Ethernet / IEEE 802.11b

SmartDeviceMonitor for Client port

IEEE 1394 (IPv4 over 1394)

SmartDeviceMonitor for Client port

❖ Windows 2000
Connection Method

Available Ports

Ethernet / IEEE 802.11b

SmartDeviceMonitor for Client port
Standard TCP/IP
LPR port

IEEE 1394 (IPv4 over 1394)

None

❖ Windows XP
Connection Method
Ethernet / IEEE 802.11b

Available Ports
SmartDeviceMonitor for Client port
Standard TCP/IP
LPR port

IEEE 1394 (IPv4 over 1394)

SmartDeviceMonitor for Client port
Standard TCP/IP

❖ Windows Server 2003
Connection Method

Available Ports

Ethernet / IEEE 802.11b

SmartDeviceMonitor for Client port
Standard TCP/IP
LPR port

IEEE 1394 (IPv4 over 1394)

SmartDeviceMonitor for Client port
Standard TCP/IP

❖ Windows NT 4.0
Connection Method

Available Ports

Ethernet / IEEE 802.11b

SmartDeviceMonitor for Client port
LPR port

IEEE 1394 (IPv4 over 1394)

None

Reference
See the explanation about how to install the printer driver for each type of
port. For the SmartDeviceMonitor for Client port, see p.25 “Using the SmartDeviceMonitor for Client Port”.

For the Standard TCP/IP port, see p.31 “Using the Standard TCP/IP Port”.
For the LPR port, see p.33 “Using the LPR Port”.
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Using as a network printer
This machine can be used as the Windows network printer, the NetWare print
server, or the NetWare remote printer.

1

ZZZ036S

Note
❒ In an IPv6 environment, Netware servers cannot be used.
Reference
See the explanation about how to install the printer driver for each type of
network printer.

For the Windows network printer, see p.35 “Using as a Windows Network
Printer”.
For the NetWare print server and remote printer, see p.37 “Using as a NetWare Print Server / Remote Printer”.
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Local Connection
Local connections can be established via parallel, USB, IEEE 1394 (SCSI print),
and Bluetooth connections.
Windows operating system version determines the available connection methods.
• Windows 95:
Parallel connections
• Windows 98:
Parallel connections
• Windows 98 SE / Me:
USB and Parallel connections
• Windows 2000:
USB, Parallel, IEEE 1394 (SCSI print), and Bluetooth connections
• Windows XP:
USB, Parallel, IEEE 1394 (SCSI print), and Bluetooth connections
• Windows Server 2003:
USB, Parallel, IEEE 1394 (SCSI print), and Bluetooth connections
• Windows NT 4.0:
Parallel connections

1

Reference
See the explanation about how to install the printer driver for each method of
connection.

For the USB connection, see p.40 “Installing the Printer Driver Using USB”.
For the parallel connection, see p.45 “Printing with Parallel Connection”.
For the IEEE 1394 (SCSI print) connection, see p.47 “Installing the Printer
Driver Using IEEE 1394 (SCSI print)”.
For the Bluetooth connection, see p.20 “Windows 2000”.
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Installing the Printer Driver
This section explains how to install the printer driver. There are two ways to install the printer driver: using Quick Install, which installs the settings at once, or
installing the appropriate driver according to the port you want to use.

1

Quick Install
Windows 95 / 98 / Me / 2000 / XP, Windows Server 2003, and Windows NT 4.0
users can easily install this software using the supplied CD-ROM.
Using Quick Install, the PCL printer driver and/or RPCS printer driver, DeskTopBinder Lite and SmartDeviceMonitor for Client are installed under network
environment, and the TCP/IP port will be set.
Important
❒ To install printer driver under Windows 2000 / XP Professional, Windows
Server 2003, and Windows NT 4.0, you must have an account that has Manage Printers permission. Log on as an Administrator.

❒ If you connect using USB, refer to p.40 “Installing the Printer Driver Using
USB” and install the printer driver.

A Quit all applications currently running.
B Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. If this happens, launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [Quick Install].
The software license agreement appears in the [License Agreement] dialog box.

E After reading the agreement, click [I accept the agreement.], and then click
[Next >].

F Select the machine model you want to use in the [Select Printer] dialog box.
For network connection via TCP/IP, select the machine whose IP address is
displayed in [Connect To].
For parallel connection, select the machine whose printer port is displayed in
[Connect To].

G Click [Install].
The printer driver installation starts.
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H Click [Finish].
A message about restarting the computer appears. Restart the computer to
complete installation.

I Click [Exit] in the first dialog box of the installer, and then take out the CD-ROM.

1

Note
❒ To stop installation of the selected software, click [Cancel] before installation is complete.

❒ Auto Run may not work with certain operating system settings. If this happens, launch “Setup.exe” on the CD-ROM root directory.
❒ Select a machine to whose IP address is displayed in [Connect To] to install
SmartDeviceMonitor for Client when using TCP/IP.
Reference
Quick Install is not available unless bidirectional communication between
the machine and computer is enabled via parallel connection. See p.56 “If
Bidirectional Communication Is Disabled” for details about bidirectional
communication between the machine and computer.
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Installing the Printer Driver for the Selected Port
Using the SmartDeviceMonitor for Client Port

1

Important
❒ To install SmartDeviceMonitor for Client under Windows 2000 / XP Professional, Windows Server 2003, and Windows NT 4.0, you must have an account that has Manage Printers permission. Log on as an Administrator.

❒ Install SmartDeviceMonitor for Client before installing the printer driver
when using the SmartDeviceMonitor for Client port.

Installing SmartDeviceMonitor for Client

A Quit all applications currently running.
B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [DeskTopBinder - SmartDeviceMonitor for Client].
E Select an interface language, and then click [Next >].
The default interface language is English.

F The message to quit all other applications appears. Quit all applications,
and then click [Next >].

G The software license agreement appears in the [License Agreement] dialog
box. After reading through its contents, click [Yes].

H Click [Full install] or [Custom Install].
[Full install] installs all required applications: DeskTopBinder Lite and SmartDeviceMonitor for Client.
[Custom Install] installs selected applications.

I Follow the instructions on the display and click [Next >] to proceed next step.
J After the installation is completed, select one of the options to restart the
computer either now or later, and click [Complete].
Restart the computer to complete installation.

Note
❒ To stop installation of the selected software, click [Cancel] before installation is complete.
❒ Auto Run may not work with certain operating system settings. If this happens, launch “Setup.exe” on the CD-ROM root directory.
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Changing the Port Settings for SmartDeviceMonitor for Client
Follow the procedure below to change the SmartDeviceMonitor for Client settings, such as TCP/IP timeout, recovery/parallel printing, and printer groups.

1

Windows 95 / 98:

A Open the [Printers] window from the [Start] menu.
B In the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

C Click the [Details] tab, and then click [Port Settings].
The [Port Settings] dialog box appears.

Windows 2000 / Windows NT 4.0:

A Open [Printers] window from [Start] menu.
B In the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

C On the [Ports] tab, click [Configure Port].
The [Configuration] dialog box appears.

Windows XP, Windows Server 2003:

A Open the [Printers and Faxes] window from the [Start] menu.
The [Printers and Faxes] window appears.

B Click the icon of the machine you want to use. On the [File] menu, click
[Properties]. The printer properties appear.

C Click the [Ports] tab, and then click [Configure Port].
The [Port Configuration] dialog box appears.
Note
❒ For TCP/IP, timeout setting can be configured.
❒ User, proxy, and timeout settings can be configured for IPP.
❒ If no settings on the [Recovery/Parallel Printing] tab are available, follow the
procedure below.
A Click [Cancel] to close the [Port Configuration:] dialog box.
B Start SmartDeviceMonitor for Client, and then right-click the SmartDeviceMonitor for Client icon on the tasktray.
C Point to [Properties], and then click [Extended Features Settings].
D Select the [Set Recovery/Parallel Printing for each port] check box.
E Click [OK] to close the [Extended Features Settings] dialog box.
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Reference
For information about these settings, see “Using SmartDeviceMonitor for
Client”, Network Guide, or SmartDeviceMonitor for Client Help.
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Installing the PCL or RPCS Printer Driver (TCP/IP)
Important
❒ To install this printer driver under Windows 2000 / XP Professional, Windows Server 2003, and Windows NT 4.0, you must have an account that has
Manage Printers permission. Log on as an Administrators or Power Users
group member.

1

A Quit all applications currently running.
B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PCL/RPCS Printer Drivers].
E The software license agreement appears in the [License Agreement] dialog box.
After reading the agreement, click [I accept the agreement.], and then click [Next >].

F Select the printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

G Click [Next >].
H Select the machine model you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

I Double-click the printer name to display the printer settings.
The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

J Click [Port:], and then click [Add].
K Click [SmartDeviceMonitor], and then click [OK].
L Click [TCP/IP], and then click [Search].
A list of printers using TCP/IP appears.

M Select the printer you want to use, and then click [OK].
Only printers that respond to a broadcast from the computer appear. To use
a machine not listed here, click [Specify Address], and then enter the IP address
or host name of the machine.

N Check that the port of the selected printer is displayed in [Port:].
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O Set a user code, if necessary.
Up to 8 numeric characters can be entered. No alphabetic character or symbol
can be entered.

P Select the [Default Printer] check box to configure the printer as default.
Q Click [Continue].

1

Installation starts.

R After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].
Restart the computer to complete installation.

Note
❒ Setting a user code allows a SmartDeviceMonitor for Admin user to display and check statistics about the number of sheets which each user
prints. For details, see SmartDeviceMonitor for Admin Help.
❒ Auto Run may not work with certain operating system settings. If this happens, launch “Setup.exe” on the CD-ROM root directory.
❒ Under Windows 95 / 98 / Me, you cannot add an IP address partially similar to the one already used. For example, if “192.168.0.2” is in use,
“192.168.0.2xx” cannot be used. Similarly, if “192.168.0.20” is in use,
“192.168.0.2” cannot be used.
Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See “When a
Message Appears during Installation of the Printer Driver”, Trouble
Shooting.
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Installing the PCL or RPCS Printer Driver (IPP)
Important
❒ To install printer driver under Windows 2000 / XP Professional, Windows
Server 2003, and Windows NT 4.0, you must have an account that has Manage Printers permission. Log on as an Administrators or Power Users group
member.

1

A Quit all applications currently running.
B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PCL/RPCS Printer Drivers].
E The software license agreement appears in the [License Agreement] dialog box.
After reading the agreement, click [I accept the agreement.], and then click [Next >].

F Select a printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

G Select the machine model you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

H Double-click the printer name to display the printer settings.
The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

I Click [Port:], and then click [Add].
J Click [SmartDeviceMonitor], and then click [OK].
K Click [IPP].
L In the [Printer URL] box, enter “http://printer's address/printer” as the printer's address.
If the server authentication is issued, to enable SSL (a protocol for encrypted
communication), enter “https://printer's address/printer” (Internet Explorer 5.01, or a higher version must be installed).
(example IP address: 192.168.15.16)
http://192.168.15.16/printer
https://192.168.15.16/printer
You can enter “http://printer's address/ipp” as the printer's address.
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M Enter a name for identifying the printer in [IPP Port Name]. Use a name different from the one of any existing port.
If a name is not specified here, the address entered in the [Printer URL] box becomes the IPP port name.

1

N Click [Detailed Settings] to make necessary settings.
For information about the settings, see SmartDeviceMonitor for Client Help.

O Click [OK].
P Check that the port of the selected printer is displayed in [Port:].
Q Set a user code, if necessary.
Up to 8 numeric characters can be entered. No alphabetic characters or symbols can be entered.

R Select the [Default Printer] check box to configure the printer as default.
S Click [Continue].
Installation starts.

T After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].
Restart the computer to complete installation.

Note
❒ To stop installation of the selected software, click [Cancel] before installation is complete.
❒ Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory.
❒ Setting a user code allows a SmartDeviceMonitor for Admin user to display and check the number of sheets each user prints. For details, see
SmartDeviceMonitor for Admin Help.
Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See “When a
Message Appears during Installation of the Printer Driver”, Trouble
Shooting.
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Using the Standard TCP/IP Port
This describes how to install the PCL or RPCS printer driver using the TCP/IP
port.

1

Important
❒ To install this printer driver under Windows 2000 / XP Professional, and
Windows Server 2003, you must have an account that has Manage Printers
permission. Log on as an Administrators or Power Users group member.

❒ In an IPv6 environment, you cannot use the Standard TCP/IP Port. Use the
SmartDeviceMonitor for Client port.

Installing the PCL or RPCS Printer Driver

A Quit all applications currently running.
B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PCL/RPCS Printer Drivers].
E The software license agreement appears in the [License Agreement] dialog box.
After reading the agreement, click [I accept the agreement.], and then click [Next >].

F Select a printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

G Click [Next >].
H Select the machine model you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

I Double-click the printer name to display the printer settings.
The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

J Click [Port:], and then click [Add].
K Click [Standard TCP/IP Port], and then click [OK].
Configure the Standard TCP/IP port settings, and then see Windows Help if
[Standard TCP/IP Port] does not appear.

L Click [Next >] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.
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M Enter the printer name or IP address in the [Printer Name or IP Address] box.
The [Port Name] text box automatically obtains a port name. Change this name
if necessary.
When the device selection appears, select “RICOH NetworkPrinter Driver C
Model”.

1

N Click [Next >].
O Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.
The installation start dialog box reappears.

P Check that the port of the selected printer is displayed in [Port:].
Q Configure the default printer as necessary.
R Click [Continue].
The printer driver installation starts.

S After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].
Restart the computer to complete installation.

Note
❒ To stop installation of the selected software, click [Cancel] before installation is complete.
❒ Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory.
Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See “When a
Message Appears during Installation of the Printer Driver”, Trouble
Shooting.
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Using the LPR Port
This describes how to install the PCL or RPCS printer driver using the LPR port.

1

Important
❒ To install this printer driver under Windows 2000 / XP Professional, Windows Server 2003, and Windows NT 4.0, you must have an account that has
Manage Printers permission. Log on as an Administrators or Power Users
group member.

Installing the PCL or RPCS Printer Driver

A Quit all applications currently running.
B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PCL/RPCS Printer Drivers].
E The software license agreement appears in the [License Agreement] dialog box.
After reading the agreement, click [I accept the agreement.], and then click [Next >].

F Select a printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

G Select the machine model you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

H Click [Next >].
I Double-click the printer name to display the printer settings.
The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

J Click [Port:], and then click [Add].
K Click [LPR Port], and then click [OK].
If [LPR Port] does not appear, see Windows Help and install it.

L Enter the printer's IP address in the [Name or address of server providing lpd]
box.

M Enter “lp” in the [Name of printer or print queue on that server] box, and then click
[OK].
The port is added.
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N Check that the port of the selected printer is displayed in [Port:].
O Configure the default printer as necessary.
P Click [Continue].

1

The printer driver installation starts.

Q After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].
Restart the computer to complete installation.

Note
❒ To stop installation of the selected software, click [Cancel] before installation is complete.

❒ Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory.
Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See “When a
Message Appears during Installation of the Printer Driver”, Trouble
Shooting.
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Using as a Windows Network Printer
This describes how to install the PCL or RPCS printer driver when using the
printer as a Windows network printer.
To use the print server, install the printer driver by selecting “Network printer
server”, and then select the Windows 2000 / XP, Windows Server 2003, or Windows NT 4.0 shared printer.
This section assumes that the client has already been configured to communicate
with a Windows 2000 / XP, Windows Server 2003, or Windows NT 4.0 print
server. Do not begin the following procedure before the client is set up and configured correctly.

1

Important
❒ To install the printer driver under Windows 2000 / XP Professional, Windows Server 2003, and Windows NT 4.0, you must have an account that has
Manage Printers permission. Log on as an Administrators or Power Users
group member.
❒ If you print with a print server connected to the printer using the SmartDeviceMonitor port, Recovery Printing and Parallel Printing cannot be used
from the client.
❒ If you print with a Windows XP or Windows Server 2003 print server, notification functions of SmartDeviceMonitor may not be used with the client.
❒ If you print with a Windows NT 4.0 print server, install the printer driver before you connect the print server to the printer.

Installing the PCL or RPCS Printer Driver

A Quit all applications currently running.
B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PCL/RPCS Printer Drivers].
E The software license agreement appears in the [License Agreement] dialog box.
After reading the agreement, click [I accept the agreement.], and then click [Next >].

F Select the printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

G Click [Next >].
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H Select the [Printer Name] check box to select the printer models you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

I Double-click the printer name to display the printer settings.

1

The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

J Click [Port:], and then click [Add].
K Click [Network Printer], and then click [OK].
L Double-click the computer name you want to use as a print server in the
[Browse for Printer] window.

M Select the printer you want to use, and then click [OK].
N Check that the port of the selected printer is displayed in [Port:].
O Configure the user code as necessary.
For an RPCS printer driver, a user code can be set after the printer driver installation. For information about user code, see the printer driver Help.

P Select the [Default Printer] check box to configure the printer as default.
Q Click [Continue].
The printer driver installation starts.

R After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].
Restart the computer to complete installation.

Note
❒ To stop installation of the selected software, click [Cancel] before installation is complete.

❒ Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory.
Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See “When a
Message Appears during Installation of the Printer Driver”, Trouble
Shooting.
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Using as a NetWare Print Server / Remote
Printer
1

This describes how to set up the Windows computer used as the NetWare client.
Important
❒ To install this printer driver under Windows 2000 / XP Professional, Windows Server 2003, and Windows NT 4.0, you must have an account that has
Manage Printers permission. Log on as an Administrators or Power Users
group member.

❒ In an IPv6 environment, Netware servers cannot be used.
The following explanation assumes NetWare Client is installed on the client
computer and the NetWare server environment is correctly set up. Install all necessary client applications before following this procedure.
Set up the printer driver while logging on to the NetWare file server.
The following values are used in the example:
• Operating system: Windows 98
• NetWare version: 4.1
• File server name: CAREE
• Queue name: R-QUEUE

A Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

B Select an interface language, and then click [OK].
The default interface language is English.

C Click [PCL/RPCS Printer Drivers].
D The software license agreement appears in the [License Agreement] dialog box.
After reading the agreement, click [I accept the agreement.], and then click [Next >].

E Select the printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

F Click [Next >].
G Select the [Printer Name] check box to select the printer model you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.
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H Double-click the printer name to display the printer settings.
The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

I Click [Port:], and then click [Add].
J Click [Network Printer], and then click [OK].
K Double-click the name of the NetWare file server on the network tree.

1

The created queue is displayed.

L Select the print queue, and then click [OK].
M Check that the port of the selected printer is displayed in [Port:].
N Click [Continue].
The printer driver installation starts.

O Click [Finish] in the [Select Program] dialog box.
P After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].
Restart the computer to complete installation.

Q After restarting the computer, launch the [Printers] window, and then open
the printer properties.
Under Windows XP or Windows Server 2003, open the printer properties
from the [Printers and Faxes] window.

R On the [Printer Settings] tab, clear the [Form Feed] and [Enable Banner] check

boxes.
Under Windows 2000 / XP, Windows Server 2003, or Windows NT 4.0, click
the [NetWare setting] tab.
Do not select these check boxes since they are automatically selected by the
printer driver. If you select the check boxes, the printer may not print correctly.

S Click [OK] to close the printer properties dialog box.
Note
❒ To stop installation of the selected software, click [Cancel] before installation is complete.

❒ The protocol is set to inactive as default. Enable it using Web Image Monitor or Telnet.
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Form Feed
Do not use NetWare to configure form feed. Form feed is controlled by the printer driver on Windows. If NetWare form feed is configured, the printer may not
print properly.
Follow the procedure below to disable form feed according to the operating system used:
• Under Windows 95 / 98 / Me, clear the [Form feed] check box on the [Printer
Settings] tab in the printer properties dialog box.
• Under Windows 2000 / XP, Windows Server 2003, or Windows NT 4.0, clear
the [Form feed] check box on the [NetWare Settings] tab in the printer properties
dialog box.

1

Banner Page
Do not use NetWare to configure a banner page.
Follow the procedure below to disable banner pages according to the operating
system used:
• Under Windows 95 / 98 / Me, clear the [Enable banner] check box on the [Printer Settings] tab in the printer properties dialog box.
• Under Windows 2000 / XP, Windows Server 2003, or Windows NT 4.0, clear
the [Enable banner] check box on the [NetWare Settings] tab in the printer properties dialog box.

Printing after Resetting the Printer
Printer to print server connection requires 30 - 40 seconds to resume after the
printer is reset. During this period, jobs may be accepted (depending on NetWare specifications) but not printed.
To print after resetting the printer as the remote printer, check on the print server
that the remote printer is disconnected, or wait for two minutes before trying to
print.
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Installing the Printer Driver Using USB
This section explains how to install printer drivers using USB.
Before installing, check that only the operating system is running on the computer and no print jobs are in progress.
The printer drivers can be installed from the supplied CD-ROM provided with
this machine.

1

Windows Me - USB
Important
❒ Installation via USB is not possible under Windows 95 / 98. Upgrade to Windows Me or later.
❒ Download USB Printing Support for Windows Me from the supplier's Web site.
When USB is first used, the plug and play function starts and the [New Hardware
Found], [Device Driver Wizard], or [Add New Hardware Wizard] dialog box appears, depending on the operating system.
If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the “USB” port is added to the [Printers] window.

A Download USB Printing Support from the supplier's Web site.
Use a search to find the model name, and then download USB Printing Support from the supplier's Web site.
Save it where you can locate it easily.

B Connect the machine to the computer using the USB cable.
Connect the USB cable firmly.

C In the Found New Hardware Wizard display, click [Search for a suitable driver
for my device [recommended]], and then click [Next >].

D Select the [Specify a location:] check box, and then click [Browse...].
The [Browse for Folder] dialog box appears.

E Specify the location where USB Printing Support is located, and then click
[Next >].

F Check the location, and then click [Next >].
USB Printing Support is installed.

G Click [Finish].
If the printer driver has already been installed, plug and play is enabled, and
the icon of the printer connected to the “USB001” port is added to the [Printers]
window.
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H Insert the printer driver. Click [Search for the best driver for your device. [Recommended]], and then click [Next >].

I Select the [Specify a location:] check box, and then click [Browse...].

1

The [Browse for Folder] dialog box appears.

J Insert the CD-ROM into the CD-ROM drive.
Note
❒ When Auto Run starts, click [Exit].

❒ To disable Auto Run, press the {Shift} key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

K Specify the location where the source files of the printer driver are stored,
and then click [Next >].
If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:
• RPCS
D:\DRIVERS\RPCS\WIN9X_ME\(Language)\DISK1
• PCL 5c (for color printing)
D:\DRIVERS\PCL5C\WIN9X_ME\(Language)\DISK1
• PCL 5e (for B & W printing)
D:\DRIVERS\PCL5E\WIN9X_ME\(Language)\DISK1
• PCL 6
D:\DRIVERS\PCL6\WIN9X_ME\(Language)\DISK1
• PostScript 3 (“Scanner Driver and Utilities” CD-ROM)
D:\DRIVERS\PS\WIN9X_ME\(Language)\DISK1

L Check the location, and then click [Next >].
Add Printer Wizard starts.

M Click [Finish].
Installation is complete. If installation is successful, the icon of the printer
connected to the “USB001” port is added to the [Printers] window.
Note
❒ The number after “USB” varies depending on the number of printers connected.

❒ It is not necessary to reinstall USB Printing Support when connecting a different machine via USB interface when USB Printing Support is installed.
❒ After installing USB Printing Support, if the printer driver is not installed,
follow the plug-and-play instructions of the printer.
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Windows 2000 - USB
Important
❒ Installing a printer driver requires Administrator permission. Log on using
an account that has Administrator permission.

1

When USB is first used, Found New Hardware Wizard starts, and USB Printing
Support is installed automatically.
If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the “USB” port is added to the [Printers] window.
If the printer driver is not installed, follow the plug-and-play instructions of the
printer to install it from the supplied CD-ROM.

A Connect the machine to the computer using the USB cable.
Connect the USB cable firmly.

B In the Found New Hardware Wizard display, click [Search for a suitable driver
for my device [recommended]], and then click [Next >].

C Select the [Specify location] check box, and then click [Next >].
D Insert the CD-ROM into the CD-ROM drive.
When Auto Run starts, click [Exit].
To disable Auto Run, press the left {Shift} key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

E Specify the location where the source files of the printer driver is stored.
If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:
• RPCS
D:\DRIVERS\RPCS\WIN2K_XP\(Language)\DISK1
• PCL 5c (for color printing)
D:\DRIVERS\PCL5C\WIN2K_XP\(Language)\DISK1
• PCL 5e (for B & W printing)
D:\DRIVERS\PCL5E\WIN2K_XP\(Language)\DISK1
• PCL 6
D:\DRIVERS\PCL6\WIN2K_XP\(Language)\DISK1
• PostScript 3 (“Scanner Driver and Utilities” CD-ROM)
D:\DRIVERS\PS\WIN2K_XP\(Language)\DISK1

F Check the printer driver location, and then click [OK].
G Click [Next >].
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H Click [Finish].
If the printer driver has already been installed, plug and play is enabled, and
the icon of the printer connected to the “USB001” port is added to the [Printers]
window.

1

Note
❒ The number after “USB” varies depending on the number of printers connected.

Windows XP, Windows Server 2003 - USB
Important
❒ Installing a printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

When USB is first used, Found New Hardware Wizard starts, and USB Printing
Support is installed automatically.
If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the “USB” port is added to the [Printers] window.
The printer drivers can be installed from the supplied CD-ROM provided with
this machine.
If the printer driver is not installed, follow the plug-and-play instructions of the
printer to install it from the supplied CD-ROM.

A Connect the machine to the computer using the USB cable.
Connect the USB cable firmly.

B In the Found New Hardware Wizard display, click [Search for a suitable driver
for my device [recommended]], and then click [Next >].

C Insert the CD-ROM into the CD-ROM drive.
If Auto Run starts, click [Cancel], and then [Exit].
To disable Auto Run, press the left {Shift} key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.
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D Select the [Include this location in the search] check box under [Search for the best

driver in these location], and then click [Browse] to select the printer driver location.
If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:
• RPCS
D:\DRIVERS\RPCS\WIN2K_XP\(Language)\DISK1
• PCL 5c (for color printing)
D:\DRIVERS\PCL5C\WIN2K_XP\(Language)\DISK1
• PCL 5e (for B & W printing)
D:\DRIVERS\PCL5E\WIN2K_XP\(Language)\DISK1
• PCL 6
D:\DRIVERS\PCL6\WIN2K_XP\(Language)\DISK1
• PostScript 3 (“Scanner Driver and Utilities” CD-ROM)
D:\DRIVERS\PS\WIN2K_XP\(Language)\DISK1

1

E Check the printer driver location, and then click [Next >].
F Click [Continue].
G Click [Finish].
If installation is successful, the icon of the printer connected to the “USB001”
port is added to the [Printers and Faxes] window.
Note
❒ The number after “USB” varies depending on the number of printers connected.
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Printing with Parallel Connection
This describes how to install the PCL or RPCS printer driver when using the parallel port.
To use a machine connected using a parallel interface, click [LPT1] when installing the printer driver.

1

Important
❒ To install this printer driver under Windows 2000 / XP Professional, Windows Server 2003, and Windows NT 4.0, you must have an account that has
Manage Printers permission. Log on as an Administrators or Power Users
group member.

Installing the PCL or RPCS Printer Driver

A Quit all applications currently running.
B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PCL/RPCS Printer Drivers].
E The software license agreement appears in the [License Agreement] dialog box.
After reading the agreement, click [I accept the agreement.], and then click [Next >].

F Select the printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

G Click [Next >].
H Select the [Printer Name] check box to select the printer model you want to

use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

I Double-click the printer name to display the printer settings.
The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

J Check that [LPT1:] is shown in [Port:].
K Select the [Default Printer] check box to configure the printer as default.
L Click [Finish].
The printer driver installation starts.
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M After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].
Restart the computer to complete installation.

1

Note
❒ To stop installation of the selected software, click [Cancel] before installation is complete.
❒ Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory.
Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See “When a
Message Appears during Installation of the Printer Driver”, Trouble
Shooting.
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Installing the Printer Driver Using IEEE 1394
(SCSI print)
1

The printer drivers can be installed from the supplied CD-ROM provided with
this machine.
Important
❒ Quit all applications currently running, and do not print during installation.

❒ Do not connect IEEE 1394 or USB devices to the computer or turn on another
printers during installation.
❒ Before uninstalling the printer driver, check that the IEEE 1394 interface cable
is disconnected from the computer.
❒ SCSI print must be set to “active” from the control panel. For details, see Network Guide.
Note
❒ This machine can receive print data from one computer at a time only. A message may appear if print jobs from different computers collide.

❒ If jobs collide, the first received job is printed first.
❒ When the printer driver is properly installed, connecting or disconnecting the
optional IEEE 1394 cable causes the printer icon to change.

Windows 2000
This describes how to install the printer driver to the computer with Windows
2000 installed, using IEEE 1394 (SCSI print).
Important
❒ If [Found New Hardware Wizard] appears every time the computer is started or
the cable is connected, disable the device. To install another printer driver after setting the “1394_00n” port, click [1394_00] as a port during the printer
driver installation.

❒ Installing this printer driver requires Administrators permission. Log on using an account that has Administrators permission.
❒ The optional 1394 interface unit can be used only with Service Pack 1 (SP1) or
higher.

A Connect the machine to the computer using the IEEE 1394 interface cable.
B Click [Next >] in the [Found New Hardware Wizard] dialog box.
C When the message “This wizard will complete the installation for this Device: Unknown” appears, click [Specify a location], and then click [Next >].

D When the message “Locate Driver Files” appears, select the [Optional search
locations.] check box, and then click [Specify a location], and then click [Next >].
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E Insert the CD-ROM into the CD-ROM drive.
• If Auto Run starts, click [Cancel], and then [Exit].
• To disable Auto Run, press the left {Shift} key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

1

F Click [Browse].
G Select the printer driver you want to use.
If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:
• RPCS
D:\DRIVERS\RPCS\WIN2K_XP\(Language)\DISK1
• PCL 5c (for color printing)
D:\DRIVERS\PCL5C\WIN2K_XP\(Language)\DISK1
• PCL 5e (for B & W printing)
D:\DRIVERS\PCL5E\WIN2K_XP\(Language)\DISK1
• PCL 6
D:\DRIVERS\PCL6\WIN2K_XP\(Language)\DISK1
• PostScript 3 (“Scanner Driver and Utilities” CD-ROM)
D:\DRIVERS\PS\WIN2K_XP\(Language)\DISK1

H Click [Open].
I Click [OK].
J Follow the on-screen instructions.
When installation is complete, the printer connected to “1394_00n” appears
in the [Printers] window: (“n” shows the number of printers connected.)
If the printer driver has already been installed, the printer icon is added to the
[Printers] window. In this case, printer driver installation is not necessary.
If printing does not work properly after the installation, delete the port and
reinstall the printer driver. For details, see Trouble Shooting
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Note
❒ If you do not want to install the printer when Found New Hardware Wizard starts under an operating system that supports SCSI print, disable the
device by following the procedure below.
A When the [Found New Hardware Wizard] dialog box appears, click [Next >].
B When the message “This wizard will complete the installation for this
Device: Unknown” appears, select the [Search for a suitable driver for my
device [recommended]] check box, and then click [Next >].
C When the message “Please choose your search and installation option.”
appears, clear all check boxes from [Search for the best driver in these locations.], and then click [Next >].
D When the message “Driver Files Search Results” appears, select the [Disable the device. The Add/Remove Hardware Wizard in the control Panel can be
able to complete the driver installations.] check box, and then click [Finish].

Installing the Printer Driver Using IEEE 1394 (SCSI print)

Windows XP, Windows Server 2003
This describes how to install the printer driver to the computer with Windows
XP or Windows Server 2000 installed, using IEEE 1394 (SCSI print).

1

Important
❒ SCSI print must be set to “active” from the control panel. For details, see Network Guide.

❒ Installing this printer driver requires Administrators permission. Log on using an account that has Administrators permission.

A Connect the machine to the computer using the IEEE 1394 interface cable.
When the [Found New Hardware Wizard] dialog box appears, check that [This wizard helps you install software for: (Unknown)] is displayed.

B Select the [Install from a list on specific location (Advanced)] check box, and then
click [Next >].

C When the message “Please choose your search and installation option.” appears, select the [Search for the best driver in these locations.] check box, select
the [Include this location in the search:] check box, and then select the [Include
this location in the search:] check box.

D Insert the CD-ROM into the CD-ROM drive.
If Auto Run starts, click [Cancel], and then [Exit].
To disable Auto Run, press the left {Shift} key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

E Specify the location where the source files of the printer driver is stored,

and then click [Next >].
If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:
• RPCS
D:\DRIVERS\RPCS\WIN2K_XP\(Language)\DISK1
• PCL 5c (for color printing)
D:\DRIVERS\PCL5C\WIN2K_XP\(Language)\DISK1
• PCL 5e (for B & W printing)
D:\DRIVERS\PCL5E\WIN2K_XP\(Language)\DISK1
• PCL 6
D:\DRIVERS\PCL6\WIN2K_XP\(Language)\DISK1
• PostScript 3 (“Scanner Driver and Utilities” CD-ROM)
D:\DRIVERS\PS\WIN2K_XP\(Language)\DISK1
When installation is complete, the printer connected to “1394_00n” appears in
the [Printers and Faxes] window. (“n” shows the number of printers connected.)
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F Follow the on-screen instructions.
If the printer driver has already been installed, the printer icon is added to the
[Printers and Faxes] window. In this case, printer driver installation is not necessary.
Even if the printer driver is already installed, the message “Found New Hardware Wizard” may appear when the machine is connected to the computer
using the IEEE 1394 interface cable for the first time. In that case, install the
printer driver.

1

Note
❒ This machine can receive print data from one computer at a time only. If a
print job from a computer collides with other data, a message may appear
on the computer.

❒ To install another printer driver after setting the “1394_00n” port, click
[1394_00] as a port during the printer driver installation.
❒ When the printer driver is properly installed, connecting or disconnecting
the optional IEEE 1394 cable causes the printer icon to change.
❒ If printing does not work properly after the installation, delete the port and
reinstall the printer driver. For details, see Trouble Shooting.
❒ If you do not want to install the printer when Found New Hardware Wizard starts under an operating system that supports SCSI print, disable the
device by following the procedure below:
A When the [Found New Hardware Wizard] dialog box appears, check that
[This wizard helps you install software for: Unknown] is displayed, select the
[Install from a list on specific location (Advanced)] check box, and then click
[Next >].
B When the message “Please choose your search and installation option.”
appears, clear all check boxes from [Search for the best driver in these locations.], and then click [Next >].
C When the message “The wizard could not find the software on your
computer for..” appears, click [OK].
D When the message “Cannot Install this Hardware” appears, select the
[Don't prompt again to install the software] check box, and then click [Finish].
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Printing with Bluetooth Connection
This describes how to print using with Bluetooth devices.

1

Supported Profiles
Refer the following supported profiles for Bluetooth connection.

❖ SPP, HCRP
• A maximum of two Bluetooth adaptor or Bluetooth-equipped computers
can be connected at the same time using the Bluetooth interface: one by
SPP, one by HCRP.
• When connecting more than one Bluetooth adaptor or Bluetooth-equipped
computer at the same time, the first device that establishes connection is selected. When selecting the connection between the other devices, cancel
the first established connection.
• SPP connection does not support bidirectional communications.
• HCRP connection supports bidirectional communications.
❖ BIP
• For BIP connection, a module including PostScript 3 must be installed in
the machine.
• Only one Bluetooth adaptor or Bluetooth-equipped computer can be connected via BIP.
• Only JPEG images that can be printed using BIP.
• User codes are disabled for BIP.
You cannot print if print functions are restricted.
• Some printers do not support BIP.
Note
❒ In this manual, the instruction referred to print using SPP. To print using
HCRP or BIP, see the Help supplied with the Bluetooth adapter you use.
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Printing with Bluetooth Connection
To install the printer driver, follow the procedure used to install parallel interface.

1

Important
❒ To install the printer driver under Windows 2000 / XP Professional or Windows Server 2003, you must have an account that has Manage Printers permission. Log on as an Administrators or Power Users group member.

A Start 3Com Bluetooth Connection Manager.
B Check that the printer you want to use appears in 3Com Bluetooth Connection Manager.

C On the [Tool] menu, click [COM port].
D Check that the message “Bluetooth Serial Client (COMx) “ appears under
Client Ports. (X indicates the COM port number used by Bluetooth.)

E Click [Close].
F On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

G Click the icon of the printer you want to use.
H On the [File] menu, click [Properties].
I Click the [Ports] tab.
J Under [Port], select the [COMx:] check box.

X indicates the COM port

number used by Bluetooth.

K Click [OK].
Close the [Printers] window.
❒
❒
❒
❒
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Note
To always use the same printer, select the [Always use for this connection]
check box.
System requirements vary depending on the Bluetooth standard and specifications. For details, see the manuals supplied with each product.
For information about setting up Bluetooth under other operating systems
or using it with different utilities, see the manuals supplied with those operating systems or utilities.
If a dialog box appears while transmitting a print job, reestablish network
connection as follows:
A Select the printer you want to use in the [Printers and Faxes] box.
B Click [Connect].
Reference
For details, see the manuals supplied with the Bluetooth adaptor or computer equipped with Bluetooth.

Printing with Bluetooth Connection

Configuring Security Mode Settings
This describes how to configure the security mode settings.

A Start 3Com Bluetooth Connection Manager.
B On the [Tools] menu, click [Security Mode].

1

The [Security Mode] dialog box appears.

C Select the security mode in the [Security Mode:] list.
If you click [High], or [Custom], and specify [Link] in the [Custom Settings] dialog
box, enter the Bluetooth password. For information about entering the password, see p.53 “Printing in the Security Mode”.
For all other security modes and custom settings, no password is required.
For information about each mode, see the manuals supplied with the utility.

D Click [OK].
Close the [Security Mode] dialog box.
Reference
For details about the security mode, see 3Com Bluetooth Connection Manager Help. For details about the password entry which is required to transmit print jobs, see p.53 “Printing in the Security Mode”.

Printing in the Security Mode
This describes how to print in the security mode.

A Send the print job to the printer in use.
Depending on the computer configuration, the [Connect] dialog box may appear. If it does, use it to establish the network connection.

B The [Authentication] dialog box appears.
C Enter the Bluetooth password, and then click [OK].
As the Bluetooth password, enter the last four digits of the machine's serial
number. You can find the serial number on the label attached to the back of
the machine. For example, if the serial number is 00A0-001234, the Bluetooth
password is 1234.

D The print job is sent.
Note
❒ The Bluetooth password differs for each machine and cannot be changed.
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Making Option Settings for the Printer
Make option settings for the machine using the printer driver when bidirectional
communication is disabled.

1

Reference
For details about making option settings for the printer, see p.56 “If Bidirectional Communication Is Disabled”.

Conditions for Bidirectional Communication
Bidirectional communication allows information about paper size and feed direction settings to be automatically sent to the printer. You can check machine
status from your computer.
• Bidirectional communication is supported by Windows 95 / 98 / Me / 2000
/ XP, Windows Server 2003, and Windows NT 4.0.
• If you use the RPCS printer driver and bidirectional communication is enabled under Windows 2000, the [Change Accessories] tab is unavailable.
Note
❒ The RPCS printer driver supports bidirectional communications and updates
the machine status automatically.

❒ The PCL printer driver supports bidirectional communications. You can update the machine status manually.
To support bidirectional communication, the following conditions must be met:

❖ When connected with parallel cables
• The computer must support bidirectional communication.
• The machine must support bidirectional communication.
• The interface cable must support bidirectional communication.
• The machine must be connected to the computer using the standard parallel cables and parallel connectors.
• Under Windows 2000, [Enable bidirectional support] must be selected, and
[Enable printer pooling] must not be selected on the [Ports] tab with the RPCS
printer driver.
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❖ When connected with the network
• The machine must support bidirectional communication.
• SmartDeviceMonitor for Client included on the CD-ROM must be installed, and TCP/IP must be used.
• Under Windows 2000, [Enable bidirectional support] must be selected, and
[Enable printer pooling] must not be selected on the [Ports] tab with the RPCS
printer driver.
• In addition to the above, one of the following conditions must also be met:
• The SmartDeviceMonitor for Client port and the TCP/IP protocol must
be used.
• The standard TCP/IP port must be used without changing the default
port name (for Windows 2000 / XP and Windows Server 2003).
• Microsoft TCP/IP print IP address must be specified for use (for Windows NT 4.0).
• IPP port name must include the IP address when using the IPP protocol.

1

❖ When connected with IEEE 1394
• The computer must support bidirectional communication.
• The machine must be connected to the IEEE 1394 connector of a computer
using the IEEE 1394 interface cable.
• [Activate] must be selected in the SCSI print of IEEE 1394 and [Activate] must
be selected in the Bidi-SCSI print.
• Under Windows 2000 / XP or Windows Server 2003, [Enable bidirectional
support] must be selected, and [Enable printer pooling] must not be selected
on the [Ports] tab with RPCS printer driver.
❖ When connected with USB
The machine must be connected to the computer's USB port using the USB interface cable.
The computer must support bidirectional communication.
Note
❒ Install SmartDeviceMonitor for Client from the supplied CD-ROM.
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If Bidirectional Communication Is Disabled
Set up option settings when bidirectional communications are disabled.

1

Important
❒ Under Windows 2000 / XP and Windows Server 2003, Manage Printers permission is required to change the printer properties in the [Printers] folder.
Log on as an Administrators or Power Users group member.

❒ Under Windows NT 4.0, Full Control permission is required to change the
printer properties in the [Printers] (Windows 2000) or [Printers and Faxes] (Windows XP / Windows Server 2003) folder. Log on as an Administrators or
Power Users group member.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.
When using Windows XP or Windows Server 2003, point to [Settings] on the
[Start] menu, and then click [Printers and Faxes]. The [Printers and Faxes] window appears.

B Click the icon of the printer you want to use.
C On the [File] menu, click [Properties].
D Click the [Change Accessories] tab.
If options in the [Change Accessories] tab are disabled, bidirectional connection
is enabled. In this case, no change is necessary for option settings.
If you are using the RPCS printer driver, click the [Change Accessories] tab.

E Select options installed from the [Options] area, and then make the necessary settings.

F Select the total amount of the memory in [Total memory:] when the optional
SDRAM module is added.

G Under [Paper source tray settings:], click and highlight the tray to be used, and
then select the appropriate size, position, and type for the tray. Select the
[Do not use Auto Tray Select] check box to exclude the tray from the targets of
automatic tray selection.

H Click [OK] to close the printer properties dialog box.
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Installing Font Manager 2000
Important
❒ Under Windows 2000 / XP, Windows Server 2003, or Windows NT 4.0, installing
applications by Auto Run requires administrator permission. To install a printer
driver by Auto Run, log on using an account that has administrator permission.

1

A Quit all applications currently running.
B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Click [Font Manager 2000].
D Follow the instructions on the screen.
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Using Adobe PageMaker Version 6.0, 6.5,
or 7.0
1

Under Windows 95 / 98 / Me / 2000 / XP, Windows Server 2003, or Windows
NT 4.0 with Adobe PageMaker, you need to copy PPD files to the PageMaker
folder.
PPD files have the .ppd extension in the folder “DRIVERS\PS\WIN9X_ME\
(Language)\DISK1” on the CD-ROM.
The “WIN9X_ME” folder inside the “PS” folder is for Windows 95 / 98 / Me.
Use the folder at this level that is appropriate for the operating system you are
currently using.
The third folder “(Language)” may be substituted by an appropriate language
name.
Copy the .ppd file to the PageMaker folder.
• For PageMaker 6.0 default installation
The directory is “C:\PM6\RSRC\PPD4”.
• For PageMaker 6.5 default installation
The directory is “C:\PM65\RSRC\USENGLISH\PPD4”.
The “USENGLISH” may vary depending on your language selection.
• For PageMaker 7.0 default installation
The directory is “C:\PM7\RSRC\USENGLISH\PPD4”.
The “USENGLISH” may vary depending on your language selection.
Note
❒ If the driver is not set correctly after copying the “.ppd” file, printing may not
be performed properly.
❒ When using PageMaker, the optional features that can be selected by the
printer driver will not be active. The following procedure describes how to
activate the optional printer features.
A On the [File] menu, click [Print].
The [Print Document] dialog box appears.
B Make the necessary settings in the [Features] box.
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2. Setting Up the Printer Driver
PCL - Accessing the Printer Properties
Windows 95 / 98 / Me - Accessing the Printer Properties
There are two methods to open the printer properties dialog box.

Making Printer Default Settings
To make the printer default settings, open the printer properties dialog box from
the [Printers] window.
Important
❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.
C On the [File] menu, click [Properties].
D Make the necessary settings, and then click [OK].
Note
❒ With some applications, the printer driver settings are not used, and the
application's own default settings are applied.
Reference
For details, see the printer driver Help.

Making Printer Settings from an Application
You can make printer settings for a specific application.
To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 95 / 98 / Me.

A On the [File] menu, click [Print].
The [Print] dialog box appears.

B Select the printer you want to use in the [Name] list, and then click [Properties].
The printer properties dialog box appears.

C Make the necessary settings, and then click [OK].
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D Click [OK] to start printing.
Note
❒ The procedure to open the printer properties dialog box may vary depending on the application. For details, see the manuals provided with the application you use.

❒ With some applications, the printer driver settings are not used, and the
application's own default settings are applied.
❒ Any settings you make in the following procedure are valid for the current
application only.
❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

2

Reference
For details, see the printer driver Help.

Windows 2000 - Accessing the Printer Properties
Making Printer Default Settings - The Printer Properties
Important
❒ To change the printer default settings including option configuration settings,
log on using an account that has Manage Printers permission. Members of the
Administrator and Power Users groups have Manage Printers permission by
default.

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.
C On the [File] menu, click [Properties].
The printer properties dialog box appears.

D Make the necessary settings, and then click [OK].
Note
❒ Settings you make here are used as the default settings for all applications.
Reference
For details, see the printer driver Help.
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Making Printer Default Settings - Printing Preferences
Important
❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].

2

The [Printers] window appears.

B Click the icon of the printer you want to use.
C On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

D Make the necessary settings, and then click [OK].
Note
❒ Settings you make here are used as the default settings for all applications.
Reference
For details, see the printer driver Help.

Making Printer Settings from an Application
You can make printer settings for a specific application.
To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 2000.

A On the [File] menu, click [Print...].
The [Print] dialog box appears.

B Select the printer you want to use in the [Select Printer] list.
C Make the necessary settings, and then click [Apply] to start printing.
Note
❒ The procedure to open the [Printing Preferences] dialog box may vary depending on the application. For details, see the manuals provided with the
application you use.

❒ Any settings you make in the following procedure are valid for the current
application only.
❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.
Reference
For details, see the printer driver Help.
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Windows XP, Windows Server 2003 - Accessing the Printer Properties
Making Printer Default Settings - The Printer Properties
Important
❒ To change the printer default settings including option configuration settings,
log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission
by default.

2

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

B Click the icon of the printer you want to use.
C On the [File] menu, click [Properties].
The printer properties dialog box appears.

D Make the necessary settings, and then click [OK].
Note
❒ Settings you make here are used as the default settings for all applications.
Reference
For details, see the printer driver Help.

Making Printer Default Settings - Printing Preferences
Important
❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

B Click the icon of the printer you want to use.
C On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

D Make the necessary settings, and then click [OK].
Note
❒ Settings you make here are used as the default settings for all applications.
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Reference
For details, see the printer driver Help.
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Making Printer Settings from an Application
You can make printer settings for a specific application.
To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows XP.

A On the [File] menu, click [Print...].
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The [Print] dialog box appears.

B Select the printer you want to use in the [Select Printer] list, and then click
[Preferences].

C Make the necessary settings, and then click [OK] to start printing.
Note
❒ The procedure to open the [Printing Preferences] dialog box may vary depending on the application. For details, see the manuals provided with the
application you use.

❒ Any settings you make in the following procedure are valid for the current
application only.
❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.
Reference
For details, see the printer driver Help.

Windows NT 4.0 - Accessing the Printer Properties
Making Printer Default Settings - The Printer Properties
Important
❒ To change the printer default settings including option configuration settings,
log on using an account that has Full Control permission. Members of the Administrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.
❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.
C On the [File] menu, click [Properties].
The printer properties dialog box appears.
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D Make the necessary settings, and then click [OK].
Note
❒ Settings you make here are used as the default settings for all applications.
Reference
For details, see the printer driver Help.

2

Making Printer Default Settings - Default
Important
❒ To change the printer default settings including option configuration settings,
log on using an account that has Full Control permission. Members of the Administrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.
C On the [File] menu, click [Document Defaults].
The [Default] dialog box appears.

D Make the necessary settings, and then click [OK].
Note
❒ Settings you make here are used as the default settings for all applications.
Reference
For details, see the printer driver Help.
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Making Printer Settings from an Application
You can make printer settings for a specific application.
To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows NT 4.0.

A On the [File] menu, click [Print].

2

The [Print] dialog box appears.

B Select the printer you want to use in the [Name] list, and then click [Properties].
The printer properties dialog box appears.

C Make the necessary settings, and then click [OK].
D Click [OK] to start printing.
Note
❒ The procedure to open the printer properties dialog box may vary depending on the application. For details, see the manuals provided with the application you use.

❒ With some applications, the printer driver settings are not used, and the
application's own default settings are applied.
❒ Any settings you make in the following procedure are valid for the current
application only.
❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.
Reference
For details, see the printer driver Help.
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RPCS - Accessing the Printer Properties
Windows 95 / 98 / Me - Accessing the Printer Properties
There are two dialog box types of the printer properties dialog box.
“Multi-tab” is used as an example in this manual. For details about changing the
dialog box types, see the printer driver Help.

2

❖ Multi-tab
This dialog box type is designed for users who often change print settings to
perform various printing operations.
❖ Custom Setting
This dialog box type is designed for users who rarely change print settings.
This type of dialog box may vary depending on the installed options.
Making Printer Default Settings
To make the printer default settings, open the printer properties dialog box from
the [Printers] window.
Important
❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.
C On the [File] menu, click [Properties].
When you open the printer properties dialog box initially after installing the
RPCS printer driver, a confirmation message appears. After clicking [OK], the
printer properties dialog box appears.

D Make the necessary settings, and then click [OK].
Note
❒ With some applications, the printer driver settings are not used, and the
application's own default settings are applied.
Reference
For details, see the printer driver Help.
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Making Printer Settings from an Application
You can make printer settings for a specific application.
To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 95 / 98 / Me.

A On the [File] menu, click [Print].

2

The [Print] dialog box appears.

B Select the printer you want to use in the [Name] list, and then click [Properties].
The printer properties dialog box appears.

C Make the necessary settings, and then click [OK].
D Click [OK] to start printing.
Note
❒ The procedure to open the printer properties dialog box may vary depending on the application. For details, see the manuals provided with the application you use.

❒ With some applications, the printer driver settings are not used, and the
application's own default settings are applied.
❒ Any settings you make in the following procedure are valid for the current
application only.
❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.
Reference
For details, see the printer driver Help.
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Windows 2000 - Accessing the Printer Properties
This describes how to launch printer driver's properties.

Making Printer Default Settings - The Printer Properties

2

Important
❒ To change the printer default settings including option configuration settings,
log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission
by default.
❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.
C On the [File] menu, click [Properties].
The printer properties dialog box appears.
When you open the printer properties dialog box initially after installing the
RPCS printer driver, a confirmation message appears. After clicking [OK], the
printer properties dialog box appears.

D Make the necessary settings, and then click [OK].
Note
❒ Settings you make here are used as the default settings for all applications.
Reference
For details, see the printer driver Help.

Making Printer Default Settings - Printing Preferences
Important
❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.
C On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.
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D Make the necessary settings, and then click [OK].
Note
❒ Settings you make here are used as the default settings for all applications.
Reference
For details, see the printer driver Help.

2

Making Printer Settings from an Application
You can make printer settings for a specific application.
To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 2000.

A On the [File] menu, click [Print...].
The [Print] dialog box appears.

B Select the printer you want to use in the [Select Printer] list.
C Make the necessary settings, and then click [Apply] to start printing.
Note
❒ The procedure to open the [Printing Preferences] dialog box may vary depending on the application. For details, see the manuals provided with the
application you use.
❒ Any settings you make in the following procedure are valid for the current
application only.
❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.
Reference
For details, see the printer driver Help.

69

Setting Up the Printer Driver

Windows XP, Windows Server 2003 - Accessing the Printer Properties
Making Printer Default Settings - The Printer Properties
Important
❒ To change the printer default settings including option configuration settings, log
on using an account that has Manage Printers permission. Members of the Administrators and Power Users groups have Manage Printers permission by default.
❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.
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A On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

B Click the icon of the printer you want to use.
C On the [File] menu, click [Properties].
The printer properties dialog box appears.
When you open the printer properties dialog box initially after installing the
RPCS printer driver, a confirmation message appears. After clicking [OK], the
printer properties dialog box appears.

D Make the necessary settings, and then click [OK].
Note
❒ Settings you make here are used as the default settings for all applications.
Reference
For details, see the printer driver Help.

Making Printer Default Settings - Printing Preferences
Important
❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

B Click the icon of the printer you want to use.
C On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

D Make the necessary settings, and then click [OK].
Note
❒ Settings you make here are used as the default settings for all applications.
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Reference
For details, see the printer driver Help.
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Making Printer Settings from an Application
You can make printer settings for a specific application.
To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows XP.

A On the [File] menu, click [Print...].

2

The [Print] dialog box appears.

B Select the printer you want to use in the [Select Printer] list.
C Make the necessary settings, and then click [Apply] to start printing.
Note
❒ The procedure to open the [Printing Preferences] dialog box may vary depending on the application. For details, see the manuals provided with the
application you use.

❒ Any settings you make in the following procedure are valid for the current
application only.
❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.
Reference
For details, see the printer driver Help.
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Windows NT 4.0 - Accessing the Printer Properties
Making Printer Default Settings - The Printer Properties
Important
❒ To change the printer default settings including option configuration settings,
log on using an account that has Full Control permission. Members of the Administrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

2

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.
C On the [File] menu, click [Properties].
The printer properties dialog box appears.
When you open the printer properties dialog box initially after installing the
RPCS printer driver, a confirmation message appears. After clicking [OK], the
printer properties dialog box appears.

D Make the necessary settings, and then click [OK].
Note
❒ Settings you make here are used as the default settings for all applications.
Reference
For details, see the printer driver Help.

Making Printer Default Settings - Default
Important
❒ To change the printer default settings including option configuration settings,
log on using an account that has Full Control permission. Members of the Administrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.
72

RPCS - Accessing the Printer Properties

C On the [File] menu, click [Document Defaults...].
The [Default] dialog box appears.

D Make the necessary settings, and then click [OK].
Note
❒ Settings you make here are used as the default settings for all applications.

2

Reference
For details, see the printer driver Help.

Making Printer Settings from an Application
You can make printer settings for a specific application.
To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows NT 4.0.

A On the [File] menu, click [Print].
The [Print] dialog box appears.

B Select the printer you want to use in the [Name] list, and then click [Properties].
The printer properties dialog box appears.

C Make the necessary settings, and then click [OK].
D Click [OK] to start printing.
Note
❒ The procedure to open the printer properties dialog box may vary depending on the application. For details, see the manuals provided with the application you use.
❒ With some applications, the printer driver settings are not used, and the
application's own default settings are applied.
❒ Any settings you make in the following procedure are valid for the current
application only.
❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.
Reference
For details, see the printer driver Help.
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3. Other Print Operations
Printing a PDF File Directly
You can send PDF files directly to the machine for printing, without having to
open a PDF application.
❒
❒
❒
❒
❒
❒

Important
This function is possible only when the optional PostScript 3 unit is installed.
This function is possible for genuine Adobe PDF files only.
Version 1.3, 1.4, and 1.5 PDF files are compatible.
Transparency and JBIG2 (functions of PDF version 1.4) are not compatible.
PDF version 1.5 exclusive functions are not compatible.
Some types of High Compression PDF files are not supported. Consult your
sales representative about the supported file types.

Note
❒ Paper size errors may occur when printing on custom size paper.

Printing Method
The following procedures explain the two methods of direct PDF printing - using DeskTopBinder Lite or by entering commands.

Using DeskTopBinder Lite
Installing DeskTopBinder Lite
Follow the procedure below to install DeskTopBinder Lite.

A Quit all applications currently running.
B Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Note
❒ Auto Run may not work under certain operating system settings. In this
case, launch “Setup.exe” located on the CD-ROM root directory.

C Select an interface language, and then click [OK].
D Click [DeskTopBinder - SmartDeviceMonitor for Client] , and then click [Next].
E Follow the instructions on the display to install DeskTopBinder Lite.
If you are required to restart the computer after installing DeskTopBinder
Lite, restart the computer and continue the configuration.
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DeskTopBinder Lite Enhancements
Follow the DeskTopBinder Lite enhancement procedure to print PDF files directly.

A On the [Start] menu, click [Programs], [DeskTopBinder], and [Extended Features
Wizard].

B When [Extended Features Wizard] appears, select [Start], and then click [Next]
repeatedly until the [Printing Functions3] screen appears.

C On the [Printing Functions3] screen, click [Add] to display [PDF Direct Print Properties].
D Select Driver for This Machine, click [OK], and then click [Next] repeatedly

3

until [Finish] is displayed.
Click [Finish].

Function Palette
The Function palette contains buttons for functions that are already configured
through DeskTopBinder Lite enhancement. Using these buttons, you can print
Windows files, preview printouts, convert images, and register scanners for documents without having to open DeskTopBinder Lite. You can also use these
functions simply by dragging a target file to the button corresponding to the required function and dropping it there.

A On the [Start] menu, click [Programs], [DeskTopBinder], and [Function Palette].
An icon for the Function palette is added to the task bar displayed at the bottom right of the screen.

B Right-click the icon that is added to the task bar, and then click [Properties]
to display the Properties screen.

C Click the [Contents] tab, select the [PDF Direct Printing] check box at the center,
and then click [OK].
The [Properties] screen closes and the [PFD Direct Printing] icon is added to the
palette.

PDF Direct Printing
Use the method below to print PDF files directly.

A Drag the PDF file you want to print to the PDF Direct Printing icon in the
palette and drop it there.

B [Output File List-PDF Direct Print] is displayed.
Highlight the PDF you want to print, and then click [OK].
The PDF file is printed.

76

Printing a PDF File Directly

Printing PDF Password-Protected Documents
Follow the procedure below to print password-protected PDF files.

A In the Windows [Start] menu, click [Programs], [DeskTopBinder], and [Extended
Features Wizard].

B When [Extended Features Wizard] appears, select [Start], and then click [Next]
repeatedly until the [Printing Functions3] screen appears.

C On the [Printing Functions3] screen, click [Properties...] to display [PDF Direct

3

Print Properties].

D Select the [Use PDF Password] check box at the bottom right of the screen, and
then click [OK].
Click [Next] repeatedly until [Finish] appears.
Click [Finish] to close the [Extended Features Wizard] screen.

E Move the PDF file you want to print to the PDF Direct Printing icon on the
palette using a drag-and-drop operation.

F [Output File List-PDF Direct Print] is displayed.
Select the PDF file you want to output to make it reverse video, and then click
[OK].

G The [PDF Direct Print Properties] screen opens.
Enter the password for the PDF file you want to print in the [PDF Password]
field at the bottom right of the screen, and then click [OK].
The password-protected PDF file is printed.
Note
❒ Before printing a password-protected PDF file, perform one of the following:

• Enter the PDF password in the PDF Direct Printing Properties screen
• Specify a PDF password by selecting [Change PDF Password] in the [PDF
Menu] menu on the control panel of this machine
❒ If a [PDF Group Password] for the [PDF Menu] menu is assigned to either
DeskTopBinder Lite or the control panel of this machine, a same group
password needs to be assigned to the other.
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PDF Direct Print Properties

1

9
2
10

3

11
12

4
5

3

6
7

13
14
15
16

8
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1. Setting Name:

9. Orientation:

Displays the plug-in configuration name
(up to 63 single byte characters)

Specifies the original's orientation.

2. Change Icon...

Specifies the number of copies to print.

Changes the icon displayed on the tool
bar.

3. Printer name:
Displays a list of RPCS drivers that support PDF direct printing.

4. Duplex

10. Number of copies
11. Collate
Sorts printed sheets.

12. Range
Specifies the print area on each page.

13. Resolution:

Prints on both sides of sheets.

Specifies a print resolution.

5. Layout

14. PDF Password:

Prints multiple pages on a single sheet.

6. Punch
Punch holes in output sheets.

7. Staple
Staple together output sheets.

8. “Display this dialog box before
printing” Dialog box

If the PDF file is password-protected, enter the password in this field. Otherwise,
the file cannot be printed.

15. Group Password:
If a group password is assigned to DeskTopBinder Lite and this machine, enter
the group password in this field. Otherwise, printing cannot start.

Appears in PDF direct printing mode if
this check box is selected.

Using commands
You can print PDF files directly, using commands such as “ftp” “sftp”and “lpr”.
Reference
For details about UNIX commands, see Network Guide.
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Unauthorized Copy Control
You can embed patterns and text under printed text to prevent unauthorized
copying of the document. Unauthorized Copy Control consists of two functions:
[Data security for copying] and [Mask type:].
Important
❒ This function is designed to discourage copying of confidential documents; it
does not prevent unauthorized use of information.

3

Opening the Unauthorized Copy Control Window

A In the RPCS printer driver, open the [Printing Preference] window.
B Click [Add/Change Custom Settings...].
C Select the [Unauthorized copy...] check box.
D Click [Control Settings...].
The Unauthorized Copy Control window appears.
Note
❒ For details, see the printer driver Help.

Using [Data security for copying]
You can embed a pattern by setting it in the printer driver.

❖ Setting [Data security for copying] in the printer driver
• Select the [Data security for copying] checkbox. You can also enter the text in
the [Text:] box.
• You cannot select the [Mask type:] checkbox at the same time.
• To print a document protected by gray overprint, the machine must be set
up correctly. Consult your administrator.
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❖ Printing a document using [Data security for copying]

3

AJL030S

1. The pattern and text you have set

3. The document is blanked by gray

is printed.

overprint.

2. The document is copied or stored
in copiers/multifunction machines
which the optional Copy Data Security unit is installed.
Note
❒ When printing a document that is set with [Data security for copying], the machine does not require the optional Copy Data Security unit to be installed.
The Copy Data Security unit is required when copying or storing a document
protected by gray overprint.
❒ Only the RPCS printer driver is supported.
❒ You cannot partially embed a pattern and text in a document.
❒ Use 182 × 257 mm (71/4 × 101/2 in.) or larger paper.
❒ Use ordinary or recycled paper of at least 70% whiteness.
❒ Duplex printing may interfere with this function as a result of text and patterns being visible through the paper.
Reference
For details about setting [Data security for copying], see the printer driver Help.
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Using [Mask type:]
You can embed patterns and text in a document by setting in the printer driver
to prevent unauthorized copying.

3
❖ Setting [Mask type:] in the printer driver
• Select a pattern from [Mask type:], and then enter text in the [Text:] box.
Note
❒ You can set only [Text:], but [Mask type:] and [Text:] must be set together.

❖ Printing a document using [Mask type:]

AJL031S

1. The pattern and text you have set
is printed palely.

3. The pattern and text you have set
appear clearly.

2. The document is copied, scanned,
or stored in copiers/multifunction
machines.
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Note
❒ Only the RPCS printer driver is supported.

❒ You cannot partially embed patterns and text strings in a document.
❒ To make the embedded pattern clear, set the character size at least 50 pt (preferably 70 to 80 pt) and character angle to between 30 and 40 degrees.
❒ Due to the effects of the settings, the results of copying, scanning, and saving
documents in the document server may vary depending on the machine
model and setting conditions.
❒ Printing with background patterns and text may be slower than normal printing.

3

Reference
For details about setting [Mask type:], see the printer driver Help.

Important Notice
• The supplier does not provide warranty regarding the appearance of print
patterns and other copy protection features. The appearance of the print patterns and the performance of Unauthorized Copy Control may vary depending on the quality of paper used and the machine model and settings.
• The supplier takes no responsibility for any damages sustained in connection
with use of or inability to make use of Unauthorized Copy Control print patterns.
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Using the Print Job Function
This describes how to print files stored in the machine.
The following types of printing can be selected using the printer driver: Sample
Print, Locked Print, Hold Print, and Stored Print.
You can print or delete the print jobs saved in the machine which is sent from
computers.
If you select Sample Print, Locked Print, and Hold Print, the print files saved in
the machine are deleted after printing is completed. If you select Stored Print,
the files remain in the machine even after printing is finished.
If you press [Print Jobs] on the Printer screen, the Complete List or the List Per
User ID screen appears depending on which list type you select from [Initial Print
Job List].

3

❖ Complete List
If you select [Complete List] from [Initial Print Job List], the following screen appears:
16
15
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A
B
C

Jobs Per User ID
Displays List Per User ID.
Complete List
Displays all files stored in the machine.
Locked Print Job List
Displays only Locked Print files stored in the machine.
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F
G
H
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I
J
K

L
M
N
O
P
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Sample Print Job List
Displays only Sample Print files stored in the machine.
Hold Print Job List
Displays only Hold Print files stored in the machine.
Stored Print Job List
Displays only Stored Print files stored in the machine.
Details
Displays details about a selected file.
[UPrevious]/[TNext]
If the list of files does not fit on the screen, scroll down to view the list.
[Delete]
Deletes a selected file.
[Print]
Prints a selected file.
[Change Password]
Changes or deletes the password of a file if a password is set. To change
the password, press [Change], enter the current password, and then enter
the new password on the confirmation screen. To delete the password,
press [Change], leave the entering/confirming a new password box blank,
and then press the [OK] key.
You can also set passwords to the Stored Print files that do not currently
have passwords.
[Clear All]
Clears all selections.
[Select All Jobs]
Selects all files stored in the machine.
Selected:
Displays number of the files selected.
[Exit]
Returns to the Printer screen.
User ID, Date/Time, and File Name display
Displays the time when the instruction to print the stored files was entered,
the User IDs, and the file names.

Using the Print Job Function

❖ List Per User ID
If you select [List Per User ID] from [Initial Print Job List], the following screen appears:
1

2
3
4
5

3

6
7

8
ANW204S

A
B
C
D
E
F
G

❒
❒
❒
❒

User ID
Displays the User IDs who sent files to the machine.
[Clear]
Deselects a selection.
[Exit]
Returns to the Printer screen.
[Complete List]
Displays all print jobs.
[List Per User ID]
Displays the print job list of each ID.
[Print All Jobs]
Prints all selected type of files sent by the user ID.
[UPrevious]/[TNext]
If the list of files does not fit on the screen, scroll down to view the list.

Note
Multiple files can be selected on the Print Jobs screen. To clear selection, press
the selected print jobs again.
The display is not updated if a new file is stored while the list of stored files
is displayed. To update the display, press {Exit} to return to the Printer
screen, and then press [Print Jobs] again.
If a large number of print jobs are stored in the machine, processing may slow
temporarily, depending on which functions are used.
If you press [List Per User ID] in the Complete List screen, the screen switches
to the List Per User ID screen where [Back] appears at the bottom right. Press
[Back] to switch to the Complete List screen.
Reference
p.87 “Sample Print”
p.91 “Locked Print”
p.95 “Hold Print”
p.98 “Stored Print”
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Selecting the Initial Print Job List
Follow the procedure below to set the initial Print Jobs screen, and to show it.

Selecting the Initial Print Job List

A Press the {User Tools/Counter} key.
B Press [Printer Features].
The Printer Features menu appears

3

C On the [System] tab, press [Initial Print Job List].
D Select either [Complete List] or [List Per User ID].

Displaying a Print Job List

A Press [Print Jobs].

Either the Complete List or List Per User ID screen appears.
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Printing from the Print Job Screen
This section gives instruction about Sample Print, Locked Print, Hold Print, and
Stored Print.

Sample Print
Use this function to print only the first set of a multiple-set print job. After you
have checked the result, remaining sets can be printed or canceled using the machine's control panel. This can reduce misprints due to mistakes in content or
settings.

3

Important
❒ A Sample Print file cannot be stored if:

• the total number of Sample Print, Locked Print, Hold Print, and Stored
Print files in the machine is over 100. (The maximum number varies depending on the volume of data in files.)
• the file contains over 2,000 pages.
• sent or stored files in the machine contain over 10,000 pages in total.
Note
❒ If a Sample Print file has not been stored properly, check the error log on the
display panel.

❒ Even after you turn off the machine, stored documents in the machine remain. However, the [Auto Delete Temporary Print Jobs] or [Auto Delete Stored Print
Jobs] settings are applied first.
❒ If the application has a collate option, make sure it is not selected before sending a print job. By default, Sample Print jobs are automatically collated by the
printer driver. If a collate option is selected from the application's [Print] dialog box, more prints than intended may be produced.
❒ If the first set of the Sample Print files is not as you expected and you do not
want to print remaining sets, delete the Sample Print file using the display
panel. If you print the remaining sets of the Sample Print file, the job in the
machine is deleted automatically.
Reference
For details about the error log on the control panel, see p.110 “Checking the
Error Log”.

For details about the [Auto Delete Temporary Print Jobs] and [Auto Delete Stored
Print Jobs], see “Printer Features”, General Settings Guide.
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Printing a Sample Print File
The following procedure describes how to print a Sample Print file with the PCL
6/5e and the RPCS printer driver. For information about how to print a Sample
Print file with the PostScript 3 printer driver, see PostScript 3 Supplement included as a PDF file on the CD-ROM.
Important
❒ Applications with their own drivers, such as PageMaker, do not support this
function.
❒ If you are using Mac OS X, you need Mac OS X v10.2 or higher to use this
function.

3

A Configure Sample Print in the printer driver's properties.
For details about configuring the printer drivers, see the relevant Help files.

B Start printing from the application's [Print] dialog box.
Make sure to set more than two copies.
The Sample Print job is sent to the machine, and the first set is printed.

C On the machine's control panel, press the {Printer} key to display the Printer
screen.

D Press [Print Jobs].

A list of print files stored in the machine appears.

E Press[Sample Print Job List].
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A list of Sample Print files stored in the machine appears.
Depending on the security settings, certain print jobs may not be displayed.

Printing from the Print Job Screen

F Select the file you want to print, and press [Print].

G Enter the new number of sets using the number keys.

3

You can enter up to 999 sets.
Press {Clear/Stop} to correct any entry mistakes.

H Press [Yes].
The remaining sets are printed.
Press [Stop] to cancel printing.
Note
❒ If you select multiple documents and do not specify the number of sets on
the confirmation screen, one set less than the number specified on the computer is printed for every selected document. If the number of sets specified on the computer is “1”, one set each is printed for every document.

❒ When the number of set quantity is changed, the changed quantity is applied to all selected files.
❒ When printing is completed, the stored file will be deleted.
❒ To stop printing after printing has started, press {Exit} until the Printer
screen appears, and then press [Job Reset]. The file will be deleted.
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Deleting Sample Print Files
If you are not satisfied with the sample printout, you can delete the Sample Print
file, revise it and print it again until the settings are suitable.

A Press the {Printer} key to display the Printer screen.
B Press [Print Jobs].
A list of the print files stored in the machine appears.

C Press [Sample Print Job List].

3

A list of Sample Print files stored in the machine appears.
Depending on the security settings, certain print jobs may not be displayed.

D Select the file you want to delete, and then press [Delete].
The delete confirmation screen will appear.

E Press [Yes] to delete the file.
The selected file is deleted.
Note
❒ If you do not want to delete the file, press [No].
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Locked Print
Use this function to maintain privacy when printing confidential documents on
the machine over a shared network. Usually, it is possible to print data using the
display panel once it is stored in this machine. When using Locked Print, it is not
possible to print unless a password is entered on the machine's display panel.
Your confidential documents will be safe from being viewed by other people.
Important
❒ A Locked Print file cannot be stored if:

3

• the total number of Sample Print, Locked Print, Hold Print, and Stored
Print files in the machine is over 100. (The maximum number varies depending on the volume of data in files.)
• the file contains over 2,000 pages.
• sent or stored files in the machine contain over 10,000 pages in total.
Note
❒ If a Locked Print file has not been stored properly, check the error log on the
display panel.
❒ Even after you turn off the machine, stored documents remain. However, the
[Auto Delete Temporary Print Jobs] or [Auto Delete Stored Print Jobs] settings are
applied first.
❒ If the application has a collate option, make sure it is not selected before sending a print job. Locked Print jobs are automatically collated by the printer
driver as default. If a collate option is selected in the application print dialog
box, more sets than intended may be printed.
❒ After the Locked Print file is printed, the job is automatically deleted.
Reference
For details about the error log on the display panel, see p.110 “Checking the
Error Log”.

For details about the [Auto Delete Temporary Print Jobs] and [Auto Delete Stored
Print Jobs], see “Printer Features”, General Settings Guide.

91

Other Print Operations

Printing a Locked Print File
The following procedure describes how to print a Locked Print file with the PCL
6/5e and the RPCS printer driver. For information about how to print a Locked
Print file with the PostScript 3 printer driver, see PostScript 3 Supplement included as a PDF file on the CD-ROM.
Important
❒ Applications with their own drivers, such as PageMaker, do not support this
function.
❒ If you are using Mac OS X, you need Mac OS X v10.2 or higher to use this
function.

3

A Configure the Locked Print in the printer driver's properties.
For details about configuring the printer drivers, see the corresponding Help
files.

B Start printing from the application's [Print] dialog box.
The Locked Print job is sent to the machine.

C On the machine's control panel, press the {Printer} key to display the Printer
screen.

D Press [Print Jobs].

A list of print files stored in the machine appears.

E Press [Locked Print Job List].
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A list of Locked Print files stored in the machine appears.
Depending on the security settings, certain print jobs may not be displayed.

Printing from the Print Job Screen

F Select the file you want to print, and then press [Print].

The password screen appears.

3

G Enter the password using the number keys, and then press {OK}.

The print confirmation screen appears.
A confirmation screen will appear if the password is not entered correctly.
Press [Exit] to enter the password again.
If multiple print files are selected, the machine prints files that correspond to
the entered password. The number of files to be printed is displayed on the
confirmation screen.
If you forgot your password, ask your network administrator for help.

H Press [Yes].
The locked file is printed.
Press [Stop] to cancel printing.
Note
❒ When printing is completed, the stored file will be deleted.

❒ To stop printing after printing has started, press {Exit} until the Printer
screen appears, and then press [Job Reset]. The file will be deleted.
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Deleting Locked Print Files

A Press the {Printer} key to display the Printer screen.
B Press [Print Jobs].
C Press [Locked Print Job List].
A list of Locked Print files stored appears.
Depending on the security settings, certain print jobs may not be displayed.

D Select the file you want to delete, and then press [Delete]

3

The password screen is displayed.

E Enter the password using the number keys, and then press [OK].
The delete confirmation screen appears.
A confirmation screen will appear if the password is not entered correctly.
Press [Exit] to enter the password again.
If you forgot the password, consult your network administrator.

F Press [Yes].
The selected file is deleted.
If you do not want to delete the file, press [No].
Note
❒ If multiple print files are selected, the machine deletes files that correspond
to the entered password. The number of files to be deleted is displayed on
the confirmation screen.
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Hold Print
Use this function to temporarily hold a file in the machine, and print it from the
computer or the machine's control panel later.
Important
❒ A Hold Print file cannot be stored if:

• the total number of Sample Print, Locked Print, Hold Print, and Stored
Print files in the machine is over 100. (The maximum number varies depending on the volume of data in files.)
• the file contains over 2,000 pages.
• sent or stored files in the machine contain over 10,000 pages in total.

3

Note
❒ If a Hold Print file has not been stored properly, check the error log on the display panel.

❒ Even after you turn off the machine, stored documents in the machine remain. However, the [Auto Delete Temporary Print Jobs] or [Auto Delete Stored Print
Jobs] settings are applied first.
❒ If the application has a collate option, make sure it is not selected before sending a print job. By default, Hold Print jobs are automatically collated by the
printer driver. If a collate option is selected from the application's Print dialog
box, more prints than intended may be produced.
Reference
For details about the error log on the display panel, see p.110 “Checking the
Error Log”.

For details about the [Auto Delete Temporary Print Jobs] and [Auto Delete Stored
Print Jobs], see “Printer Features”, General Settings Guide.

Printing a Hold Print File
The following procedure describes how to print a Hold Print file with the PCL
6/5e and the RPCS printer driver. For information about how to print a Hold
Print file with the PostScript 3 printer driver, see Postscript 3 Supplement included as a PDF file in the supplied CD-ROM.
Important
❒ Applications with their own drivers, such as PageMaker, do not support this
function.
❒ If you are using Mac OS X, you need Mac OS X v10.2 or higher to use this
function.

A Configure Hold Print in the printer driver’s properties.
For details about configuring the printer drivers, see the relevant Help files.

B Click [Details...], and then enter a User ID in the [User ID:] box.
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C Start printing from the application’s [Print] dialog box.
The Hold Print job is sent to the machine and stored.

D On the machine’s control panel, press the {Printer} key to display the printer screen.

E Press [Print Jobs].

3

F Press [Hold Print Job List].

A list of a print files stored in the machine appears.
Depending on the security settings, certain print jobs may not be displayed.

G Select the file you want to print, and press [Print].

The confirmation screen appears.

H Press [Yes].
The Hold Print file is printed.
Press [Stop] to cancel printing.
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Note
❒ When printing is completed, the stored file is deleted.

❒ To stop printing after printing has started, press {Exit} until the Printer
screen appears, and then press [Job Reset]. The file will be deleted.
Reference
For details about setting printer drivers, see the printer driver Help. You
can also print or delete a Hold Print file from Web Image Monitor. For details, see Web Image Monitor Help.

3

Deleting Hold Print Files

A Press the {Printer} key to display the Printer screen.
B Press [Print Jobs].
A list of print files stored in the machine appears.

C Press [Hold Print Job List].
A list of a Hold Print files stored in the machine appears.
Depending on the security settings, certain print jobs may not be displayed.

D Select the file you want to delete, and then press [Delete]
The delete confirmation screen appears.

E Press [Yes] to delete the file.
The selected file is deleted.
If you do not want to delete the file, press [No].
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Stored Print
As print files are not deleted after printing is completed, sending the same print
file every time is not necessary, effective when printing same files repeatedly.
Important
❒ A Stored Print file cannot be stored if:

• the total number of Sample Print, Locked Print, Hold Print, and Stored
Print files in the machine is over 100. (The maximum number varies depending on the volume of data in files.)
• the file contains over 1,000 pages.
• sent or stored files in the machine contain over 2,000 pages in total.

3

Note
❒ If a Stored Print file has not been stored properly, check the error log on the
display panel.

❒ Even after you turn off the machine, stored documents remain. However, the
[Auto Delete Temporary Print Jobs] or [Auto Delete Stored Print Jobs] settings are
applied first.
❒ If the application has a collate option, make sure it is not selected before sending a print job. By default, Stored Print jobs are automatically collated by the
printer driver. If a collate option is selected from the application's Print dialog
box, more prints than intended may be produced.
Reference
For details about the error log on the display panel, see p.110 “Checking the
Error Log”.

For details about the [Auto Delete Temporary Print Jobs] and [Auto Delete Stored
Print Jobs], see “Printer Features”, General Settings Guide.
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Printing a Stored Print File
The following procedure describes how to print a Stored Print file with the PCL
6/5e and the RPCS printer driver. For information about how to print a Stored
Print file with the PostScript 3 printer driver, see Postscript 3 Supplement included as a PDF file on the supplied CD-ROM.
Important
❒ Applications with their own drivers, such as PageMaker, do not support this
function.
❒ If you are using Mac OS X, you need Mac OS X v10.2 or higher to use this
function.

3

A Configure Stored Print in the printer driver’s properties.
You can select two ways for Stored Print:
• [Stored Print]
Stores the file in the printer and print it later using the display panel.
• [Store and Normal Print]
Prints the file at once and also stores the file in the machine.
For details about configuring the printer drivers, see the relevant Help files.

B Click [Details...], and then enter a User ID in the [User ID:] box.
You can also set a password. The same password must be entered when printing or deleting.

C Start printing from the application’s [Print] dialog box.
The Stored Print job is sent to the machine and stored.

D On the machine’s control panel, press the {Printer} key to display the Printer screen.

E Press [Print Jobs].
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F Press [Stored Print Job List].

A list of Stored Print files stored in the machine appears.

3

G Select the file you want to print, and press [Print].

The confirmation screen appears.
If you set a password in the printer driver, a password confirmation screen
appears. Enter the password.
If multiple print files are selected, the machine prints files that correspond to
the entered password and files that do not require a password. The number
of files to be printed is displayed on the confirmation screen.
If you forgot your password, ask your network administrator for help.

H Enter the number of sets using the number keys.

You can enter up to 999 sets.
Press {Clear/Stop} to correct any entry mistakes.

I Press [Yes].
The Stored Print file is printed.
Press [Stop] to cancel printing.
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Note
❒ When multiple print files are selected, the minimum number of set quantity among all settings is applied.

❒ When the number of set quantity is changed, the changed quantity is applied to all selected print files.
❒ To stop printing after printing has started, press [Exit] until the Printer
screen appears, and then press [Job Reset]. A Stored Print file is not deleted
even if [Job Reset] is pressed.
❒ The Stored Print file that sent to the machine is not deleted unless you delete a file or select [Auto Delete Stored Print Jobs] (see “Printer Features”, General Settings Guide).

3

Reference
For details about setting printer drivers, see the printer driver Help. You
can also print or delete a Stored Print file from Web Image Monitor. For details, see Web Image Monitor Help.

Deleting Stored Print Files

A Press the {Printer} key to display the Printer screen.
B Press [Print Jobs].
A list of print files stored in the machine appears.

C Press [Stored Print Job List].
A list of Stored Print files stored in the machine appears.
Depending on the security settings, certain print jobs may not be displayed.

D Select the file you want to delete, and press [Delete].
The delete confirmation screen appears.
If you set the password in the printer driver, enter the password to delete.
If multiple print files are selected, and some of these require a password, the
machine deletes files that correspond to the entered password and files that
do not require a password. The number of files to be deleted is displayed on
the confirmation screen.
If you forgot the password, consult your network administrator.

E Press [Yes] to delete the file.
The selected file is deleted.
If you do not want to delete the file, press [No].

101

Other Print Operations

Printing from the Jobs Per User ID Screen
This describes how to print the files saved in the machine from the User ID
screen.

Printing the Selected Print Job

A Press the {Printer} key.
The Printer screen appears.

3

B On the Printer screen, press [Print Jobs].

A list of user IDs whose files are stored in the machine appears.

C Press the user ID whose file you want to print.

You cannot select multiple user IDs at the same time.
Press [UPrevious] or [TNext] to scroll through the list.
Press [Clear] to cancel a selection.
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D Press [List Per User ID].

3

The print job list of the selected user ID appears.

E Select the desired print jobs.

To cancel a selection, press the highlighted print job again. To clear all selections, press [Clear All].

F Press [Print].
The confirmation screen appears.

G Press [Yes].
The selected files are printed.
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Printing All Print Jobs

A Press the {Printer} key.
The Printer screen appears.

B On the Printer screen, press [Print Jobs].

3

A list of user IDs whose files are stored in the machine appears.

C Press the user ID whose file you want to print.

You cannot select multiple user IDs at the same time.
Press [UPrevious] or [TNext] to scroll through the list.
Press [Clear] to cancel a selection.

D Press [Print All Jobs].

If the selected user ID has multiple types of print jobs, the selection screen of
the print job type appears.
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E Select the desired print job type, and then press [OK].

The confirmation screen appears.
The confirmation screen does not appear if the selected ID has only one type
of print jobs.

3

F Press [Yes].
The selected files are printed.
Note
❒ After printing is completed, Sample Print, Locked Print, and Hold Print
files are deleted.
❒ You cannot select a print job that is not stored under the selected user ID.
❒ If you select multiple Sample Print Files and do not specify the number of
sets on the confirmation screen, one set less than the number specified on
the computer is printed for every selected document. If the number of sets
specified on the computer is “1”, one set each is printed for every document.
❒ If you select Stored Print, the number you set on the confirmation screen is
applied to all files of the selected print job type. If you do not set a quantity,
the minimum number is applied to all files.
❒ If you select Locked Print, enter the correct password. If there are multiple
passwords, the machine prints only files that correspond to the entered
password.
❒ If you select Stored Print files, and some of these require a password, the
machine prints files that correspond to the entered password and files that
do not require a password.
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Form Feed
This section gives instructions for operating the machine when there is no tray for
the selected paper size or type, or when paper loaded in the machine has run out.
Important
❒ The tray cannot be changed if the following functions are set:

•
•
•
•
•
•
•
•

3

Staple
Punch
Duplex Print to a tray that does not support duplex printing
Cover Sheet
Front or Back Covers
Slip Sheet
Chaptering
Z-folf

Note
❒ If form feed is selected for a tray with the following settings, you can change
the tray by canceling the settings:

• Staple
• Punch
• Duplex Print to a tray that does not support duplex printing
❒ If Auto Continue is selected, form fed paper is printed after a set interval. See
“Printer Features”, General Settings Guide.

Printing from a Selected Tray
If the machine does not have a tray for the selected paper size or paper type, or
if the selected paper loaded in the machine has run out, a caution message appears. If this message appears, do the following procedure.

A Press the {Printer} key.
B Select the tray for form feed from those that appear on the display panel.
If you want to print after adding paper to the tray, select the tray after loading
the correct paper.

C Press [OK].
The machine prints using the selected tray.
Note
❒ If a tray with a smaller paper size is selected, the print job may be cut short,
or other problems may occur.
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Canceling a Print Job
Follow the procedure below for canceling the print job if the message prompting
form feed appears.

A Press the {Printer} key.
The Printer screen appears.

B Press [Job Reset].
Delete the stored print jobs, and then cancel form feed.

3

C Press [Reset the Job] to cancel the current print job, or [Reset All Jobs] to cancel
all jobs.
A confirmation message appears.

D Press [Yes] to cancel the print job.
Press [No] to return to the previous display.
Note
❒ To resume printing print jobs, press [Resume Printing]
❒ If the machine is shared by multiple computers, be careful not to accidentally cancel someone else's print job.
❒ Under Windows, if the machine is connected to the computer using a parallel cable, sent print jobs may be canceled if [Reset All Jobs] is pressed
while “Waiting...” is on the display panel. After the interval set in [I/O Timeout] in Printer Features has passed, the next print job can be sent. A print
job sent from a different client computer will not be canceled in this case.
❒ You cannot stop printing data that has already been processed. For this
reason, printing may continue for a few pages after you press [Job Reset].
❒ A print job containing a large volume of data may take considerable time
to stop.
Reference
For details, see p.108 “Canceling a Print Job”.
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Canceling a Print Job
This section gives instruction to stop printing from the computer or the display
panel.

Canceling a Print Job Using the Control Panel

A Press the {Printer} key.
The Printer screen appears.

3

B Press [Job Reset].

C Press [Reset the Job] or [Reset All Jobs].

• [Reset the Job]: cancels the print job currently being processed.
• [Reset All Jobs]: cancels all jobs in the print queue.
• [Resume Printing]: resumes printing print jobs.
A confirmation message appears.

D Press [Yes] to cancel the print job.
Press [No] to return to the previous display.
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Windows - Canceling a Print Job from the computer
You can cancel a print job from the computer if transferring print jobs is not completed.

A Double-click the printer icon on the Windows task tray.
A window appears, showing all print jobs currently queued for printing.
Check the current status of the job you want to cancel.

B Select the name of the job you want to cancel.
C On the [Document] menu, click [Cancel].
D Press the {Printer} key on the machine's control panel.
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Note
❒ If the machine is shared by multiple computers, be careful not to accidentally cancel someone else's print job.

❒ If the machine is connected to the computer using a parallel cable, sent
print jobs may be canceled if [Reset All Jobs] is pressed while “Waiting...”
is on the display panel. After the interval set in [I/O Timeout] in Printer Features has passed, the next print job can be sent. A print job sent from a different client computer will not be canceled in this case.
❒ Under Windows XP, Windows Server 2003, or Windows NT 4.0, click [Cancel] on the [Document] menu.
❒ Under Windows 95/98/Me/2000 or Windows NT 4.0, you can also open
the print job queue window by double-clicking the machine icon in the
[Printers] machine window (the [Printers and Faxes] window under Windows XP and Windows Server 2003).
❒ You cannot stop printing data that has already been processed. For this
reason, printing may continue for a few pages after you press [Job Reset].
❒ A print job containing a large volume of data may take considerable time
to stop.
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Checking the Error Log
If files could not be stored due to printing errors, identify the cause of the errors
by checking the error log on the control panel.
Important
❒ The most recent 50 errors are stored in the error log. If a new error is added
when there are 50 errors already stored, the oldest error is deleted. However,
if the oldest error belongs to one of the following print jobs, it is not deleted.
The error is stored separately until the number of those errors reaches 30. You
can check any of these print jobs for error log information.
• Sample Print
• Locked Print
• Hold Print
• Stored Print
❒ If the main power switch is turned off, the error log is deleted.

3

A Press the {Printer} key.
The Printer screen appears.

B Press [Error Log].

An error log list appears.
Depending on the security settings, certain errors may not be displayed.

C Press the desired job list.
You can select job list from [Complete List], [Locked Print Job List], [Sample Print
Job List], [Hold Print Job List], or [Stored Print Job List].

D Select the print file you want to check, and then press [Details].
A detailed error log appears.
Press [UPrevious] or [TNext] to scroll the error files.
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Note
❒ Press [Exit] after checking the log.
❒ Press [Back to List] to return to the error log list.
❒ To print files that appear in the error log, resend them after stored files
have been printed or deleted.

Spool Printing

Spool Printing
Spool Printing allows print jobs transferred from a computer to be temporarily
stored, and then prints them after they are transferred. This shortens printing
time as it maximizes printer efficiency.
Important
❒ During Spool Printing, the hard disk is accessed and the Data In indicator
blinks. Turning off the computer or machine during Spool Printing can damage the hard disk. Also, if the computer or machine is turned off during Spool
Printing, spooled jobs will be deleted. Therefore, do not turn the power of the
computer or machine off during Spool Printing.
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❒ If data is sent to the machine using other protocols besides diprint, lpr, ipp,
ftp, sftp, and smb, Spool Printing cannot be performed.

❖ Setting Spool Printing
Spool Printing can be set using telnet or Web Image Monitor.
• Using Web Image Monitor
See Network Guide or Help for more information.
• Using telnet
Type in “spoolsw spool on” to set Spool Printing.
See Network Guide for more information about telnet.
❖ Viewing a list of spool jobs on the display panel
If Spool Printing is set, a list of spooled jobs can be viewed on the display panel screen.
Press the {Printer} key, and then press [Spooling Job List]. A list of spooled jobs
appears.
• Deleting jobs
Select files to be deleted, and then press [Delete].
❖ Viewing/Deleting spool jobs in Web Image Monitor
Start Web Image Monitor and enter the machine's IP address in the address
bar. This displays the top page.
For more information, see Network Guide.
Note
Up to a maximum of 150 jobs at once can be spool printed.
If Spool Printing is not set, you cannot select [Spooling Job List].
Printing the first page with Spool Printing will be slow.
The computer requires less print processing time when large amounts of data
are spooled.
❒ Stored spool jobs can be viewed or deleted using Web Image Monitor.

❒
❒
❒
❒
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User Defined Pages
Using this function, you can specify the page numbers for each input tray.
Important
❒ This function is available with the PCL 6/5e printer driver only.
❒ If [Document Server] is selected under [Job Type:], User Defined Page cannot be
used.
❒ If [User Defined Pages] is selected under [Paper Selection:] on [Paper] tab, [Layout:] cannot be selected.

3

AEV044S

Reference
For printing methods, see the printer driver Help.
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Printing with the Finisher
You can collate, staple, or punch holes in printed paper by installing the optional
finisher. Make sure you read the following precautions when using the optional
finisher.
Important
❒ Make option settings for the machine using the printer driver when bidirectional communication is disabled.

❒ Be sure to set the paper size and paper orientation in the printer driver when
using duplex printing, booklet printing, combined printing (layout), staple
and punch functions.
❒ The machine can have only one of the following installed at any one time:
3,000Sheet-50Sheet Staple Finisher, 3,000Sheet-100Sheet Staple Finisher,
Booklet Finisher, Shift Tray, or Copy Tray.
❒ The optional Mailbox can be installed with the 3,000Sheet-50Sheet Staple Finisher or Booklet Finisher. The optional Mailbox cannot be installed if the
3,000Sheet-100Sheet Staple Finisher, Shift Tray, or Copy Tray is installed.

3

Note
❒ Depending on the application, print settings may not be enabled and printed
output may not be as expected.

❒ When setting Staple or Collate in the printer driver, make sure that the Collate
check box is cleared in the application's [Print] dialog box. If Collate is enabled
in the application, printing will not be as intended.
❒ When printing restarts after removing jammed paper, the printing position
may be different, depending on the location of the jam.
• If the paper jam occurred in the optional finisher, printing will restart from
the top page of the data currently being printed, or from the page where
the paper jam occurred.
• If the paper jam occurred in the machine, printing will restart from the
page where the paper jam occurred.
❒ Even if the paper jam occurred in the machine, the error will not be cleared
unless the cover of the finisher is opened and closed.
Reference
For details about duplex printing, booklet printing, or combined printing
(layout), see the printer driver Help.

For information about optional finishers, see General Settings Guide.
To remove paper misfeeds, see Trouble Shooting.
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Staple
With the optional 3,000Sheet-50Sheet Staple Finisher, 3,000Sheet-100Sheet Staple Finisher or Booklet Finisher installed, sets can be stapled individually when
printing multiple sets.

Staple Position
The specified staple position varies depending on paper size, type, quantity and
feed orientation. The following table shows staple positions:

3

ANW001S

Note
❒ Stapling might not be in the specified position if combine (layout) and duplex
printing are both selected. After setting the staple position, use the printer
driver's preview icon to check the position before printing.
Reference
For paper sizes and maximum numbers of sheets available for stapling, see
“Specifications”, General Settings Guide.

For printing methods, see the printer driver Help.
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Stapling Precautions
Important
❒ Stapling can be done only with the optional finisher installed.

❖ Staple printing will be canceled under the following conditions:
• If the number of pages exceeds maximum for stapling.
• If a paper size that cannot be stapled is selected.
• If a paper type that cannot be stapled is selected.
• If positions other than those fixed for stapling are specified.
• If there are inconsistencies between the orientation in the duplex mode and
the staple position.
• If there are inconsistencies between the orientation in letterhead mode and
the staple position.
• If paper sizes are mixed when a different paper size is specified during a
print job.
• When feeding paper from the bypass tray.
• When staples have run out and Auto Continue is set (Printing will continue without stapling after the message has been displayed).
• When only 1 page is printed When staples have run out.

3

Note
❒ When the stapling is cancelled, “BD: Staple has been cancelled.” appears.

❒ If Staple or Shift Collate is selected with the optional 3,000Sheet-50Sheet Staple Finisher, 3,000Sheet-100Sheet Staple Finisher and Booklet Finisher installed, the paper will be output to the finisher shift tray irrespective of the
setting.
❒ When printing on letterhead, stapling may not be at the specified position.
❒ If you cannot make staple settings even with 3,000Sheet-50Sheet Staple Finisher, 3,000Sheet-100Sheet Staple Finisher, and Booklet Finisher installed, options may not be set correctly in the printer driver. Correct option settings in
the printer driver. For details, see the printer driver Help.
❒ When the finisher is being used for another function's job (for example, a copy
job), printing will start after that job ends.
❒ Be sure to set paper size and orientation in the printer driver when stapling.
❒ When duplex printing is selected, adjust staple positions to the binding orientation.
❒ Depending on the software you are using, print settings may not be saved
and the printed result may not be as expected.
❒ When setting Staple in the printer driver settings, make sure that a collate option is not selected in the print settings of the application. If a collate option is
selected in the application, printing will not be as intended.
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Punch
With the optional 3,000Sheet-50Sheet Staple Finisher, 3,000Sheet-100Sheet Staple Finisher, Booklet Finisher, or both the Mailbox and Punch Kit is installed,
holes can be punched into printed output.

Punch Position
The specified punch position varies depending on paper feed and print data orientation. The following table shows punch positions:

3

ANV101S

Note
❒ Punch positions will vary slightly from page to page as holes are punched
into each sheet individually.
Reference
For information about paper sizes that can be punched, see “Specifications”,
General Settings Guide.

For printing methods, see the printer driver Help.
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Punching Precautions
Follow these precautions when using the punch function.
Important
❒ This function is possible only when the optional 3,000Sheet-50Sheet Staple
Finisher, 3,000Sheet-100Sheet Staple Finisher, or both the Mailbox and Punch
Kit is installed.

❖ Punch printing will be canceled under the following conditions:
• When a paper type that cannot be punched is selected.
• When a paper size that cannot be punched is selected.
• If positions other than those fixed for punching are specified.
• If there are inconsistencies between the orientation in duplex mode and the
punch position.
• If there are inconsistencies between the orientation in letterhead mode and
the punch position.
• When feeding paper from the bypass tray.
• When the punch receptacle has become full and Auto Continue is set
(Printing will continue without punching after the message appears).
• If there are inconsistencies between the staple position and the punch position, when using with staple function.

3

Note
❒ When the punching is cancelled, “BE: Punch has been cancelled.” appears.
❒ Punching might not be in the specified position when printing on letterhead
paper.
❒ If you cannot make punch settings even with the optional finisher installed,
options may not be set correctly in the printer driver. Correct option settings
in the printer driver. For details, see the printer driver Help.
❒ When duplex print is selected, adjust the punch position to the binding direction.
❒ Be sure to set the punch position the same as the staple position when using
it with the staple function.
❒ Be sure to set paper size and orientation in the printer driver when punching.
❒ Depending on the application, print settings may not be enabled and printed
output may not be as expected.
❒ When setting Punch in the printer driver settings, make sure that a collate option is not selected in the print settings of the application.
❒ If a collate option is selected in the application, printing will not be as intended.
❒ The punch function and Z-fold function cannot be selected concurrently.
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Collate
When printing multiple documents such as handouts for meetings, you can separate sets into order. This function is known as “Collate”. Collate stores data
transmitted from a computer to the printer memory or hard disk drive. The following are the three types of Collate:
Important
❒ If Auto Continue occurs on the first set, Collate will be canceled.

❒ If forced printing occurs on the first set, Collate will be canceled.
❒ When setting Collate in the printer driver settings, make sure that a collate
option is not selected in the application's print settings. If a collate option is
selected, printing will not be as intended.

3

Note
❒ Set Collate and Rotating collate when using the RPCS printer driver.

❒ Follow the procedure below when using the printer driver other than the
RPCS:
• Set Collate and Rotating Collate in the printer driver.
• If you cannot make Shift Collate even with the optional finisher installed,
options may not be set up correctly in the printer driver. Correct the printer
driver's option settings.
• For details, see the printer driver Help.

Collate
Printed output is assembled as sets in sequential order.

AEU016S
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Rotating collate
Every other print set is rotated by 90 degrees.

AEU017S

3

Important
❒ The Rotating Collate function requires two paper trays containing same size
paper but in different orientations.
❒ If the output tray has shift function, Shift Collate will be applied even if Rotating Collate is selected.

❖ When Rotate Collate is cancelled
If the following functions are selected, Collate or Shift Collate will be applied
even if Rotating Collate is selected:
• When combined with staple function.
• When combined with punch function.
• When combined with z-fold function.
• If jobs containing pages of various sizes are set.
• When output tray is specified.
• When combined with covers function.
• When combined with slip sheet function.
• When combined with chaptering function.
• When combined with tab sheet function.
• If custom size paper is set.
Note
❒ When Rotating Collate has been selected, printing speed will be slower than
with other collate functions.

Shift collate
The optional finisher is required for this function.
The finisher shift tray moves backward or forward when a job or set is output,
causing the next to shift, so you can separate them.

AEU018S
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Covers
Using this function, you can insert cover and back sheets fed from a different
tray to that of the main paper, and print on them.
Important
❒ To use this function, Collate must be set. Rotating Collate cannot be set.

❒ The cover sheets should be the same size and orientation as the body of the
paper.

3

❖ Cover sheet
Prints the first page of the document on the sheet for the cover page.
• Print on one side
Prints on one side of the cover sheet only, even when duplex printing is selected.

AEV016S

• Print on both sides
Prints on both sides of the cover sheet when duplex printing is selected.
• Front cover printed on both sides

AEV017S

• Front cover printed on one side

AEV032S
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Covers

• Blank
• When printing one side

AEV018S

• When printing both sides

3

AEV033S

❖ Back cover
Prints the last page of the document as the back cover pages.
• Print on one side
Prints on one side of the cover sheets only, even when duplex printing is
selected.
• Back cover page face inside

AMT202S

• Back cover page face outside

AMT207S
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• Print on both sides
Prints on both sides of the cover sheets when duplex printing is selected.
• Back cover page face inside, and the number of pages is odd

AMT203S

3

• Back cover page face outside, and the number of pages is odd

AMT204S

• Back cover page face inside, and the number of pages is even

AMT205S

• Back cover page face outside, and the number of pages is even

AMT206S
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Covers

• Blank
• When printing one side

3

AEV040S

• When printing both sides

AEV041S

Note
❒ If “Auto Tray Select” is set as the paper feed tray for the body paper, the paper
will be delivered from a tray containing paper in the K orientation. Therefore, if the cover paper is set to the L orientation, the orientation of cover and
body will be different.
Reference
For printing methods, see the printer driver Help.
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Chaptering
The specified page is printed on the same side as the first page, like a book. Also,
you can insert chapter slip sheets before specified pages, and select whether or
not to print on the slip sheets.

No slip sheets
The specified page is always printed on the same side as the first page.

3

AJO025S

Note
❒ This function is only valid with duplex printing.

❒ Up to 100 pages can be specified as the front pages of chapters using the printer driver.
❒ This function can be used together with combine (layout) printing.
Reference
For printing methods, see the printer driver Help.
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Chaptering

Inserting chapter slip sheets
Insert chapter slip sheets before the specified page.
• Print
Prints on the chapter slip sheets. When duplex printing is selected, both sides
of the slip sheets are printed on.

3

AJO023S

• Blank

AJO024S

Note
❒ Up to 100 pages can be specified as the front pages of chapters using the printer driver.

❒ The slip sheet should be the same size and orientation as the body of the paper.
❒ If “Auto Tray Select” has been set as the paper feed tray for the body paper,
the paper will be delivered from a tray containing paper in the K orientation.
Therefore, when the cover paper has been set to the L orientation, the orientation of the output cover paper and body paper will be different.
❒ The same paper feed tray cannot be set for the body of the document and the
slip sheet.
Reference
For printing methods, see the printer driver Help.
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Slip Sheet
❖ a slip sheet between each page
• Print

3

AEV019S

• Blank

AEU023S

❖ Inserting a slip sheet between OHP transparencies
• Print

AEV020S

• Blank

AEU024S

Note
Collate cannot be set when using slip sheets.
When the duplex printing or cover printing is set, you cannot insert slip sheets.
The slip sheet should be the same size and orientation as the main paper.
If “Auto Tray Select” has been set as the paper feed tray for the body paper,
the paper will be delivered from a tray containing paper in K orientation.
Therefore, when the cover paper has been set to L orientation, the orientation of the output cover paper and body paper will be different.
❒ The same paper feed tray cannot be set for the main paper and slip sheets.

❒
❒
❒
❒
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Tab Sheet

Tab Sheet
Prints on tab sheets.

GCPY025E

3

Important
❒ Make sure to install the optional tab sheet holder when setting tab sheets.
Contact your service representative regarding the optional tab sheet holder
installation.
❒ Only tab sheets with the tab on the right (at the top part of the paper) can be
printed on.
Reference
For information about tab sheets size that can be printed, see the “General Settings Guide”.

For printing method, see the printer driver Help.
Note
❒ Make sure to check the position of the tab beforehand, so that images to be
printed do not come out slanted. If there are any letters in a position where
the tab is not present, toner may dirty the back of the paper.
❒ If there are any inconsistencies between the position of the tab, the staple and
the punch hole, the tab position will be prioritized.
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Z-fold
You can Z-fold prints when the optional Z-folding unit and the optional
3,000Sheet-100Sheet Staple Finisher or Booklet Finisher are attached.

Folding Positions
When Z-folding, select the folding positions for the front page using the printer
driver.
The relationship between the size of the front page and that of subsequent pages
determines whether the subsequent pages can be Z-folded.

3

Feed
direction

Front page
Print direction

A
B
C

ABC

Folding position*1

Result

Right fold

A
B
C

Bottom fold

A
C

Left fold

A
B
C

Right fold

AC

Bottom fold

ABC

Left fold

AC

Z-fold not possible

Z-fold possible

Z-fold not possible

Z-fold possible

Z-fold not possible

Z-fold possible
AEW009S

Subsequent pages
Paper size

Result*2

Larger than front page

Z-fold possible

Smaller than front page

Z-fold not possible
AEW010S

*1
*2
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Select the folding position according to the print direction.
If the size of the paper is the same as that of the front page, the paper can be Z-folded
only if the front page can be Z-folded.

Z-fold

Notes on the Z-fold Function
Follow these precautions when using the punch function.

❖ Z-folding will be canceled under the following conditions:
• When the Z-fold function is not supported for the selected paper type
• The Z-fold function is not supported for OHP transparencies, labels, thick
paper, translucent paper, and tab stock paper.
• When form feeding is used
• When the paper is fed from the optional interposer tray
• The rotating collate and auto tray switching cannot be used when Z-folding.
• When using Booklet Finisher.

3

Note
❒ You can Z-fold with A3, A4, B4, 11"×17", 8 1/2"×11", and 8 1/2"×14" paper.

❒ Z-folded paper can be stapled.
❒ When stapling Z-folded paper, fewer sheets than normal can be stapled together. This is because a single Z-folded sheet is equivalent to 10 non-Z-folded sheets.
❒ The Z-fold function and punch function cannot be used together. If the Z-fold
function is used, punch function settings are canceled.
The output has the following appearance:

ABC ABC

AC AC

A
B
C

ABC

Left fold

AC AC

ABC

ABC

A4

A3

ABC

R

A4

A5

A
B
C

R

A4

A5

AC AC

AC R
A
B
C

R

A
C

A3

AC

A
B
C

AC

AC AC

ABC

A4

A
B
C

A
C

A BC

AC

R

AC

R

R

A
B
C

ABC

A4

AC

A4

ABC

A4

A
C

A4

A
B
C

Bottom fold

ABC

ABC

ABC

A
B
C

Right fold

AC

Front page, Subsequent pages

A
B
C

R
ANW013S
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4. Saving and Printing Using
the Document Server
Accessing the Document Server
The Document Server enables you to store documents on the machine's hard
disk, allowing you to edit and print as you, and when you, want.
Important
❒ Applications with their own drivers, such as PageMaker, do not support this
function.
Note
❒ When you use the Document Server, the following functions can be selected
using the machine's control panel:

❒
❒
❒
❒

❒

❒

• Copies
• Collate
• Duplex
• Staple
• Z-fold
• Paper selection: Paper source tray, paper type, paper output tray.
• Functions related to paper selection: Cover Sheet, Slip Sheet.
The above items are dimmed, so you cannot set them from the printer properties dialog box when the Document Server is selected.
You must enter a user ID, using up to eight alphanumeric characters.
You should enter a Password and File Name to distinguish the job from others.
Up to 3,000 files can be stored in the Document Server. No new files can be
stored after 3,000 is reached. Even if less than 3,000 files are stored, new files
cannot be stored when
• a file to be stored contains more than 2,000 pages,
• the total number of pages contained in files stored exceeds 10,000,
• the hard disk is full.
The Document Server also stores files scanned using the Automatic Document Feeder (ADF) or exposure glass. You should delete unnecessary stored
files once in a while so as not to exceed the capacity of the hard disk. For details about deleting stored files, see General Settings Guide.
When using the hard disk for functions other than those of Document Server,
you may not be able to store new files in the Document Server, even if there
are less than 3,000 files stored.
Reference
For more information about Document Server functions, see General Settings
Guide.

For information about how to access Document Server from a client, see the
printer driver Help.
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5. The Functions and Settings
of the Machine
Mainframe
Network Guide, PostScript 3 Supplement, and UNIX Supplement cover all models, and therefore contain all the functions and settings. This chapter describes
the functions and setting items used for configuring the model you are using.
Reference
For details about functions and setting items, see Network Guide, PostScript
3 Supplement and UNIX Supplement.

Functions
The following functions are available with the machine:
• Copy
• Printer
• Scanner
• Document Server
Note
❒ The machine must be equipped with the Printer/Scanner Unit in order to use
the printer or scanner function.

Interface
The following interfaces are available with the machine:
• Ethernet (100BASE-TX/10BASE-T)
• USB (2.0)
• IEEE 1284 (Parallel)(Optional)
• IEEE 1394 (Optional)
• IEEE 802.11b (Wireless LAN)(Optional)
• Bluetooth (Optional)
• Ethernet (1000BASE-T)(Optional)
Note
❒ To use the IEEE 1284, IEEE 1394, IEEE 802.11b (wireless LAN), Bluetooth or
Ethernet (Optional) interface, the machine must be equipped with the corresponding unit for that interface.
❒ You cannot have the IEEE 1394, IEEE 1284, IEEE 802.11b (wireless LAN), and
Bluetooth interface on the machine at the same time.
❒ You cannot have the standard Ethernet and the optional Ethernet interface on
the machine at the same time.
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List of the Setting Items
Web Image Monitor
The following tables show Web Image Monitor items that can be viewed or modified depending on the selected mode on the Web browser.
Select one of the following modes to log on Web Image Monitor:
• User mode: log on as a user
• Administrator mode: log on as an administrator

❖ Home
• Status
Menu

5

User mode

Administrator mode

Toner

Read

Read

Input Tray

Read

Read

Output Tray

Read

Read

• Configuration
Menu

User mode

Administrator mode

Function

Read

Read

System

Read

Read

Version

Read

Read

Printer Language

Read

Read

• Counter
Menu

User mode

Administrator mode

Copier

Read

Read

Printer

Read

Read

Send/TX Total

Read

Read

Scanner Send

Read

Read

Other Function (s)

Read

Read

• Inquiry
Menu
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User mode

Administrator mode

Machine Maitenance/Repair

Read

Read

Sales Representative

Read

Read

List of the Setting Items

❖ Document Server
• Document Server
User mode

Administrator mode

Read/Modify

Read/Modify

❖ Printer: Print Jobs
• Print Job List
User mode

Administrator mode

Read/Modify

Read/Modify

❖ Job
• Job List
Menu

User mode

Administrator mode

Current/Waiting Jobs

Read

Read

Job History

Read

Read

5

• Printer
Menu

User mode

Administrator mode

Job History

Read

Read

Error Log

Read

Read

Document Server

Read

Read

❖ Address Book
• Address List
Menu
Address Book

User mode
None

Administrator mode
Read/Modify
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❖ Configuration
• Device Settings
Menu

5

User mode

Administrator mode

System

Read

Read/Modify

Paper

Read

Read/Modify

Date/Time

Read

Read/Modify

Timer

Read

Read/Modify

Logs

Read

Read/Modify

E-mail

Read

Read/Modify

Auto E-mail Notification

None

Read/Modify

On-demand E-mail Notification

None

Read/Modify

File Transfer

None

Read/Modify

User Authentication Management

None

Read/Modify

Administrator Authentication Management

None

Read/Modify

Program/Change Adminis- None
trator

Read/Modify

LDAP Server

Read/Modify

None

• Printer
Menu

User mode

Administrator mode

Basic Settings

Read

Read/Modify

Tray Parameters (PCL)

None

Read/Modify

Tray Parameters (PS)

None

Read/Modify

PDF Temporary Password

Modify

None

PDF Group Password

None

Modify

PDF Fixed Password

None

Modify

• Interface
Menu
Interface Settings
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User mode
Read

Administrator mode
Read/Modify
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• Network
Menu

User mode

Administrator mode

IPv4

Read

Read/Modify

IPv6

Read

Read/Modify

NetWare

Read

Read/Modify

AppleTalk

Read

Read/Modify

SMB

Read

Read/Modify

SNMP

None

Read/Modify

SNMPv3

None

Read/Modify

SSDP

None

Read/Modify

Bonjour

Read

Read/Modify

System Log

Read

Read

• Security
Menu

User mode

5

Administrator mode

Network Security

None

Read/Modify

Access Control

None

Read/Modify

IPP Authentication

None

Read/Modify

SSL/TLS

None

Read/Modify

ssh

None

Read/Modify

Site Certificates

None

Read/Modify

DeviceCertificates

None

Read/Modify

• RC Gate
Menu

User mode

Administrator mode

Setup RC Gate

None

Read/Modify

Update RC Gate Firmware

None

Read/Modify

RC Gate Proxy

None

Read/Modify

• Webpage
Menu
Webpage

User mode
Read/Modify

Administrator mode
Read/Modify
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• Extended Feature Settings
Menu

User mode

Administrator mode

Startup Setting

None

Read/Modify

Install

None

Read/Modify

Uninstall

None

Read/Modify

Administrator Tools

None

Read/Modify

Copy Extended Features

None

Read/Modify

Copy Card Save Data

None

Read/Modify

Note
❒ Some items are not displayed depending on the security settings.

5
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telnet
The following telnet can be used with the machine:
access, appletalk, authfree, autonet, bonjour (rendezvous), btconfig, devicename, dhcp, diprint, dns, domainname, help, hostname, ifconfig, info, ipp, ipv6,
lpr, netware, passwd, prnlog, route, set, show, slp, smb, snmp, sntp, spoolsw,
sprint, ssdp, ssh, status, syslog, upnp, web, wiconfig, wins

Settings that can be used with PostScript 3
The following PostScript 3 settings can be used with the machine:
Note
❒ Depending on a type of printer drivers, different items may be displayed.
Settings

Selectable Items

Collate:

Off, On

Dithering:

Auto, Photographic, Text, User Setting

Duplex:

Off, Open to Left, Open to Top

Fit to Print Size:

Prompt User, Nearest Size and Scale, Nearest Size and Crop

Image Smoothing:

Off, On, Auto, Less than 90 ppi, Less than 150 ppi, Less than
200 ppi, Less than 300 ppi

Input Tray:

AutoSelect Tray, Bypass Tray, Tray 1(LCT), Tray 2, Tray 3,
Large Capacity Tray

Output Tray:

Printer Default, Copy Tray, Finisher SR970/4000 Upper Tray,
Finisher SR970/4000 Shift Tray, Fnisher SR4000 Booklet Tray,
Finisher SR841 Upper Tray, Finisher SR841 Shift Tray, Booklet
Processor Tray, Mailbox Tray 1–9

Resolution

600 dpi, 1200dpi

Size:

See General Setting Guide.

Staple:

Off, Top Left, Top Right, 2 at Left, 2 at Right, 2 at Top, 2 at Center

Edge Smoothing

On, Off

Toner Saving

On, Off

Type:

See General Setting Guide.

Paper Selection

Same Paper for All Pages, Different Paper for First Page, Use
Slip Sheet, Chaptering

Punch:

Off, 2 at Left, 2 at Right, 2 at Top, 3 at Left, 3 at Right, 3 at Top,
4 at Left, 4 at Right, 4 at Top

5
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6. Appendix
Specifications
This section contains the machine's electrical and hardware specifications, including information about its options.
Component
Resolution

Specifications
1200 × 1200 dpi
600 × 600 dpi
300 × 300 dpi

Printing speed

• Type 1:
55ppm
• Type 2:
65ppm
• Type 3:
75ppm
(A4K, 81/2 × 11 K plain paper)
Printing speeds depend on the machine. Check which type of machine you have. See General Settings Guide.

Interface

Standard:
• Ethernet interface (100BASE-TX/10BASE-T)
• USB 2.0 interface
Option:
• IEEE 1284 parallel interface
Use a standard 36-pin printer cable not longer than 3 meters (10 feet).
• IEEE 1394 interface
• IEEE 802.11b wireless LAN interface
• Bluetooth interface
• USB Host interface
• Ethernet interface (1000BASE-T)

Network protocol

IPv4, IPv6, IPX/SPX, AppleTalk

Printer language

Standard: PCL 6/5e, RPCS
Option: PostScript 3, PDF Direct

Fonts

PCL 6/5e:
Monotype Imaging 35 Intellifonts, 10 TrueType fonts, 13 International fonts, and 1 Bitmap font.
PostScript 3 :
136 fonts (Type 2:24, Type 14:112)

Memory

512 MB

Hard disk

Storage capacity : 80 GB

Network cable

100BASE-TX/10BASE-T shielded twisted-pair (STP, Category/Type5) cable.
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Component
USB Interface (Standard)

Specifications
• Supported Operating System:
Windows Me/2000/XP, Windows Server 2003, MacOS 10.3.3
or later
• Transmission spec.
USB 2.0 Standard
• Connectable Device:
Devices corresponding to USB 2.0 Standard

Note
❒ When using MacOS, use only the USB Interface (Standard). The optional USB
host interface board is not supported.

❒ When using the USB Interface (Standard) with Mac OS 10.3.3, USB2.0 is supported.
❒ When using the USB Interface (Standard) with Windows Me, install USB
Printing Support. Windows Me only supports USB 1.1 speed.

6
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Specifications

Options
Important
❒ Only one optional interface board can be installed in the machine at a time.
Therefore, the optional IEEE 1394 interface board, the IEEE 802.11b interface
unit, the IEEE 1284 interface board, and Bluetooth interface unit cannot be installed concurrently.

IEEE 1394 Interface Board Type B
❖ Transmission spec.:
IEEE 1394
❖ Interface:
IEEE std 1394-1995 compliant
IEEE std 1394a-2000 compliant
❖ Device class:
SCSI print (Windows 2000/XP, Windows Server 2003)
IP over 1394 (Windows Me/XP, Windows Server 2003)

6

❖ Protocol:
SBP-2 (SCSI print)
TCP/IP (IP over 1394)
❖ Interface connector:
IEEE 1394 (6 pin × 2)
❖ Required cable:
1394 interface cable (6 pin × 4 pin, 6 pin × 6 pin)
Note
❒ You cannot plug devices together to create loops.
❒ Do not use cable that is more than 4.5 meters in length.

❖ Data transfer speed:
Maximum 400 Mbps
❖ Connectable number of devices on a bus:
Maximum 63
❖ Allowed cable hops on a bus:
Maximum 16
❖ Power supply:
Non external power supply
Cable Power repeated (IEEE 1394a-2000 compliant)
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IEEE 1284 Interface Board Type A
❖ Transmission spec.:
IEEE 1284
❖ Required cable:
Standard IEEE 1284 compliant Micro Centronics 36 pin cable
IEEE 802.11b Interface Unit Type H
❖ Transmission spec.:
Based on IEEE 802.11b (wireless LAN)
❖ Protocol:
TCP/IP, IPX/SPX, AppleTalk
Note
❒ SmartDeviceMonitor and Web Image Monitor are supported.

❖ Data transfer speed:
Auto select from below speed
1 Mbps, 2 Mbps, 5.5 Mbps, 11 Mbps

6

❖ Frequency range:
• Inch version:
2412 - 2462 MHz (1 - 11 channels)
• Metric version:
2412 - 2472 MHz (1 - 13 channels)
❖ Transmittable distance:
1 Mbps 400 m
2 Mbps 270 m
5.5 Mbps 200 m
11 Mbps 140 m
Note
❒ These figures are a guideline for outdoor use. In general, the transmittable
distance indoors is 10 - 100 m, depending on environment.

❖ Transmission mode:
Ad hoc, and infrastructure mode
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Bluetooth Interface Unit Type 3245
❖ Supported Profiles:
• SPP (Serial Port Profile)
• HCRP (Hardcopy Cable Replacement Profile)
• BIP (Basic Imaging Profile)
❖ Frequency Range:
2.45 GHz ISM band
❖ Data Transmission Speed:
723 kbps
Note
❒ The transmission speed is adjusted according to factors such as the distance and obstacles between the devices, radio signal condition and Bluetooth adaptor.

❖ Maximum Range:
10 m

6

USB Host Type A
❖ Interface Connector:
USB 1.1 host interface A type
❖ Data Transmission Speed:
12 Mbps (Full speed)
❖ Distance Between Devices:
2.5 m
Gigabit Ethernet Type 7300
❖ Interface Connector:
• Ethernet (10Base-T, 100Base-TX, 1000Base-T)
• USB 2.0
It requires a USB computer port and cable that support USB 2.0.
❖ Data Transmission Speed:
• Ethernet: 1000 Mbps, 100 Mbps, 10 Mbps
• USB: 480 Mbps (High speed: USB 2.0), 12 Mbps (Full speed)
❖ Protocol:
TCP/IP, IPX/SPX, AppleTalk
❖ Distance Between Devices:
• Ethernet: 100 m
• USB: 5 m
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Bluetooth Interface Unit Type 3245, 145
Bypass tray, 12
Custom size paper using the control
panel, 15
setting the paper size using the control
panel, 14

C
Canceling a job
Windows, 108
Changing the order of jobs, 6
Chaptering, 124
Checking Job History, 7
Checking jobs in the print queue, 5
Collate, 118
Control panel
hold print, 95
locked print, 91
printer features, 8
sample print, 87
stored print, 98
Covers, 120
Custom size paper
printing, bypass tray, 12

D
Deleting jobs, 7
Display panel, 2
Document Server, 131

E
Error log, 110

F
Finisher, 113
Font Manager 2000, 57
Fonts, 141

G
Gigabit Ethernet Type 7300, 145
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Hard disk, 141
Holding print jobs, 6
Hold print
deleting, 97
printing, 95
How to Read This Manual, 1

I
IEEE 1284 Interface Board Type A, 144
IEEE 1394 Interface Board Type B, 143
IEEE 802.11b Interface Unit Type H, 144
Initial Display, 2
Inserting chapter slip sheets, 125
Installing the printer driver
Quick Install, 23
Installing the Printer Driver Using USB, 40
Interface, 141

J
Job List, 4
Job List screen, 4

L
List Per User ID
printing all print jobs, 102, 104
printing the desired print job, 102
Locked print
deleting, 94
printing, 92

M
Manuals for This Machine, i
Memory, 141

N
Network cable, 141
Network protocol, 141
No slip sheets, 124

O
OHP Transparencies
printing, bypass tray, 16
Operating system, 141
Options, 143

P
PageMaker, 58
PDF Direct Print, 75
Printer Features Menu, 8
Printer language, 141
Printing a PDF file directly
PDF direct print, 75
Printing Method
PDF direct print, 75
Printing speed, 141
Printing with Bluetooth Connection
Windows, 51
Printing with Parallel Connection
Windows 2000, 45
Punch, 116

R
Resolution, 141
Rotating collate, 119

S
Sample print
deleting, 90
printing, 88
Shift collate, 119
Simplified Display, 3
Slip Sheet, 126
Specifications, 141
Spool printing, 111
Staple, 114
Stored print
deleting, 101
printing, 99

T
Tab Sheet, 127
Thick Paper
printing, bypass tray, 16

U
Unauthorized copy control, 79
data security for copying, 79
mask type, 81
USB Host Type A, 145
Using commands, 78
Using the Print Job Function, 83

W
Windows
canceling a job, 108
Windows 2000
printer properties, PCL, 60
printer properties, RPCS, 68
Windows 95/98/Me
printer properties, PCL, 59
printer properties, RPCS, 66
Windows NT 4.0
document defaults, PCL, 64
document defaults, RPCS, 72
printer properties, PCL, 63
printer properties, RPCS, 72
Windows Server 2003
printer properties, PCL, 62
printer properties, RPCS, 70
Windows XP
printer properties, PCL, 62
printer properties, RPCS, 70
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Note to users in the United States of America

Note:
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications. However, there is no guarantee that interference will not occur
in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to
correct the interference by one more of the following measures:
Reorient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.
Consult the dealer or an experienced radio /TV technician for help.

Caution:
Changes or modifications not expressly approved by the party responsible for compliance could void
the user's authority to operate the equipment.

Declaration of Conformity
Product Name: Printer/Scanner Controller
Model Number: Printer Scanner Unit Type 7500
Responsible party: Ricoh Corporation
Address: 5 Dedrick Place, West Caldwell, NJ 07006
Telephone number: 973-882-2000
This device complies with Part 15 of the FCC Rules.
Operation is subject to the following two conditions:
1. This device may not cause harmful interference, and
2. this device must accept any interference received,
including interference that may cause undesired operation.
1. Properly shielded and grounded cables and connectors must be used for connections to a host
computer (and/or peripheral) in order to meet FCC emission limits.
2. An AC adapter with a ferrite core must be used for RF interference suppression.
Note to users in Canada

Note:
This Class B digital apparatus complies with Canadian ICES-003.

Remarque concernant les utilisateurs au Canada

Avertissement:
Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.

Copyright © 2005
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